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VISUAL SHOW DIRECTOR 8 Getting Started 

Introduction 

 

This guide is designed to introduce you to the use of "Show Director" and "Visual Show 

Director. 
 

Show Director is a professional tool for designing pyrotechnic pyromusical shows for a 

variety of firing systems.  

. 

Visual Show Director provides you with additional Visual Applications, for 3D visualization 

of fireworks. lasers, lights, image projections and objects animation to enhance your creative 

experience. 
 

In the following guide we will use only the name "Visual Show Director". For "Show 

Director" users disregard references to visualization. 
 

READ THE INSTRUCTIONS FOR INSTALLATION AND LICENSE ACTIVATION (QUICK START) 
 
 

How to use this guide 
 

The guide is divided into several chapters. You can read the chapters in order, or you can 

read the rest of this Introduction and then start with the chapter that best suits your interest 

and experience. Within each chapter, we recommend following the instructions in order. 

 

We recommend that you do a thorough read first to familiarize with the functionality contents 

of the software and after come back to use it as a reference to implement the use of them 

when necessary. 
 
 

Other Resources 
 

Visual Show Director includes a variety of resources to help you learn the program quickly 

and become proficient in creating your own effects and libraries. These resources include the 

following: 

 

 A Demo Project 

Included in the installation package there is a Demo Project to start practicing with. 

Download from here:www.infinityvisions.net/DEMOS/2019DEMOLIB.zip 
 

 Visual Show Director's Online Help 

Includes comprehensive information about using all aspects of Visual Show Director, as 

well as an HTML version online and video 

tutorials.www.infinityvisions.net/software/documentation  
 

 Visual Show Director  in program Help is located in the installation folder as 

vsd.chm. 
 
 

In addition, you may find updated versions of this help and video tutorials on our 

website. 

And YOUTUBE CHANNEL 

file:///C:/Users/an/Dropbox/INFINITY%20VISIONS%20SOFTWARE/HELP-VSD/VisualShowDirector%208%20Quick%20Start%20Guide
https://youtu.be/J-yOsjInjCc
https://youtu.be/J-yOsjInjCc
http://www.infinityvisions.net/software/documentation/
http://www.infinityvisions.net/software/documentation/
https://www.youtube.com/user/PyroCreator4D/playlists
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Upgrading to version 8 from previous versions (Skip this section if you are new to 8.4.) 

If you are a new user or are upgrading to version 8 from previous versions here are all the 

new features.  
 

For Importing Previous versions Projects see Video Tutorial here. 
    

WHAT WAS  NEW IN VERSION 8.3?   
 

Read Release Notes 

 

WATCH VIDEO 

 

BACKWARDS COMPATIBLE 
 

 Project Import in the "Project Library". Will import older projects, versions 5,6,7 and will export a 

copy of a VSD8 project. It will make a copy of all the older files selected and a new .pyr. 
Export will export to versions 5, 6 , 7 or make a copy of version 8 projects and selected files. 
 

 Direct open/import from the "File menu" of "Scripts", "Effects Manager"s, Sorts and Filters from 

versions 5,6, and 7. 
Copies of original version files will be saved as "samename". "file extension".bak in the same folder. 

Older projects can not be opened directly from the File Menu, they need to be imported with Project 
Library. 
 

 Project Save As… Makes a copy of the existing .grx and .atb files and copies them to the new 

project before it saves. This fixes the missing column colors/formatting in the new project if the script 
windows was closed.4. Automatic version update notifications.5. You can now associate ShowDirector8 to 

.pyr project files. This allows you to double click a .pyr project file and have ShowDirector open with that 

project loaded. 
 

AUTO-RESTORE (UNDO) 
 

 New Auto Restore for Scripts and Effects Managers. This new function will keep a backup of your 

most recent Scripts or Effects Managers making a copy of the files every 5 minutes within 1 hour. There 

will be 12 copies that you can restore at any point on time. The feature is only active with a project open. 

The backup files are stored in a folder inside the directory where the project is saved. 
The function can be manually deactivated by changing On to Off in the file sd.ini in C:/Users/your 

username/Appdata/Roaming/ShowDirector.  
You will never lose more than 5 minutes of work. 
 

        
 

 
 

https://youtu.be/J-yOsjInjCc
http://www.infinityvisions.net/Documentation/Show%2520Director%25208.3%2520Release%2520Notes%25203.pdf
https://youtu.be/3vBT8fgWz4g
https://youtu.be/3vBT8fgWz4g


VISUAL SHOW DIRECTOR 8 

7 / 137  

MORE COLUMNS 
 

 Added new Script columns; MS (MILLISECONDS),MACRO,GROUP,TABLE,MODE, CONTROLLER, 

MODULE, PIN, CUSTOM 3>8, LOCK1 > LOCK 8 columns added to Script. Included in Filter and Sort. This 

supports different firing system functionalities. The new columns are initially hidden and you can show 

them with the show/hide tool in the format toolbar. 
 

 Added new columns to Effects Manager grid: Custom3-5. The columns from Effects Manager 

overwrite the values in Script Manager. Script Manager. also got three additional Custom (6-8) that do not 

get overwritten as they don't exist in effects. All new columns are shown. REF column widened from 16 to 
50 characters. 
 

 All ShowDirector Managers Grids now support Column Cut and Paste. It is limited to columns on 

the same grid and of the similar data types. Some data types can't be copied between columns (for 
example, while you can put a CUE number into a text field such as CUSTOM3, you can't put that CUSTOM3 

value back into the CUE). 
To copy a column or a section of it: select the cell to start, press Shift and select the last row, press Shift-

F4 or the icon tool in the Sort/Filter toolbar, click in the cell you want to start the paste and press Shift+F5 
or icon tool. 
 

MULTI-FIRING SYSTEM SCRIPTING 
 

 Script Import and Export for: FireOne (.fir) , Galaxis, PyroLeda, Explo, Cobra... 
 

 The Script Open and Save As and have been expanded to include the new columns. Script Open 

from .xls, or .csv and older scripts (VSD 5,6,7) that do not have the new columns. The new columns will be 

blank. 
Columns in Excel have to be named with the same characters and format as VSD. 

Excel with one workbook has to be named as "Sheet1". 
The Effects Manager export and import has .csv and Excel (.xls) format. 
 

MULTI FIRING SYSTEM AUTO-ADDRESSING 
 

 New Renumber Address dialog for ADDR and Module/Pin will dynamically display the Script Sort 

you have (up to 10 columns) that can be selected to cause the Renumber to increment to the next Module 

when that value in that column changes. It also allows you to specify if you want the pin addresses to 
increment or decrement (default). Once a module is full, we increment to the next module. The Reset 

Address also has a new dialog that allows you to specify either 
 
 
 

 ADDR or MODULE/PIN 
 

 The Validate Addresses form has now a Module Report function that will display a count of Total 

Firing Modules and available pins not used. 
 

 Reset Address, Renumber Address and Validate Address now work on both ADDR column and the 

new MODULE/PIN columns. When you run the menu items, it works on both the ADDR and MODULE/PIN. 
 

 Module and Pin AutoComplete. You can AutoComplete incrementing or decrementing by any 

amount. Currently the maximum pin value is 100. To AutoComplete select first cell and shift last row and 
press CTRL+F9 
 

NEW TIME FORMATS AND DIRECT EDIT AND SEQUENCING IN THE TIME COLUMNS 
 

 Cue Time (HH MM SS FF) remain in frame rate. We have added a MS (milliseconds) column that 

contains the Cue Time represented in total milliseconds. If you change any of the Cue Time values, the MS 

column will update. If you change the MS column, the Cue Time values will update. 
 

http://www.infinityvisions.net/doc_vsd/cm_renumberaddresses.html
http://www.infinityvisions.net/doc_vsd/cm_renumberaddresses.html
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 The Next column has been changed to allow edits. This makes the interval between two cues as 

settable. If you change the value of in the Next column, the Cue Time and MS will update. If other Next 

values exist, then all following Cue Times will also update with their intervals. Thus, if you change a Next 
time interval, you slide the entire show by that much time. How this effects the show can be manipulated 

by the filters and selections you have in place at the time of the edit to the Next value. Copy Down and 
AutoComplete also works for the Next column allowing you to generate linear and curved interval 

sequences. A valid Next edit can be as a number from 1 on up as milliseconds or in the format of 

mm:ss:ms (minutes, seconds, milliseconds), however the display will always show mm:ss:ms. 
It is also possible to Copy parts of the NEXT column and Paste in other Cues to set the same intervals. 
 

 Increased the precision of the PFT (Pre-Fire Time) from 1/10s of a second to milliseconds. You can 
enter any number from 1 (millisecond) to 9999. Zero is still valid and indicates no pre-fire time. This 

change should be reflected in both the Script and the Effects files. When exporting to previous versions it 

will reformat the PFT as 1/10 sec. When importing from older versions it will convert 1/10 sec into 
milliseconds. When creating the Firing Table .tab for the PD Field Controller it will export as 1/10sec. 
 

 Configure Timecode form now allows to change the Frames format of the open Script. If you are in 

30fps and select 25fps the Script will change to that format. 
 

FIND-REPLACE & ADDITIVE FILTERS 
 

 Added universal Find/Replace in all the Managers. Shift+F3. 
 

 Script and Effects Quick Filter are additive now. If you have a filter in place and select a new Quick 

Filter, it will add to the end of the existing filter. This continues until you select Reset Filter. 
 

USER INTERFACE ADAPTABILITY 
 

 Added Major Version number (8) to the .grx and .atb filenames. This will help facilitate the 

organization and addition of new columns and tools to ShowDirector. 

The default toolbar (.atb in appdata/roaming/ShowDirector) when it opens does not show all the toolbars 
possible. To Open other toolbars, right click in the grey area and select them from the menu or from 

Customize. 
 

 The default grid (.grx in appdata/roaming/ShowDirector) has a new order of columns and doesn't 

show all the columns possible. If you want to reorganize this default grid, show more columns or hide 

other and in different order, do the following. Reopen ShowDirector, do not open a project, Open a new 
script, show/hide and reorder, do the same with toolbars shown/hidden and distribution. Close the script. 

Restart Show Director. The new default layout will be displayed. Colors for colors are only part of a Project. 

If you want to use a particular project layout, make a template and every time you make a new project 
open the template first and save the new project with new name. 
 

 ToolbarLayout (.atb) and GridLayout (.grx) files gained the Minor version number. This means if a 

menu changes or a grid column changes, we will advance the product Minor version and refuse to load the 
old, out-of-date layout files. A side effect is that any custom formatting in the old version is lost to the new 

version. Default .atb and .grx files in the users/AppData/Roaming/ShowDirector folder have been made 
Read-Only to preserve them against possible corruption by loading out of date script or effect files when no 

project has been loaded. 
 

RELEASE 8.3.4 
 

 From the Show Director menu Windows->Window Layout, an additional feature has been added 
that allows all of a projects layout files to be returned to factory defaults. 

 Added REF column to the Cues Auto Complete feature. 

 Added Cue Invert to work on the REF column.  This column has been added to Cue Invert, but if 
you do Invert cells in the column be sure to Refresh References to have all the Effect data catch up 
with the associated new cues. 

 In SD Tools, PyroDigital table download has a new feature to output the script to a FSK encoded 
wave file. 
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 In SDTools, allow for the creation of FSK encoded time-code files. 

 In SDTools, the Audio Editor was no longer supportable and has been replaced by a new tool to 
allow for the combination of any two wave files.  It supports combining left and right channels and 
lead-in silence per channel.  Perfect for creation of music/time-code combined music files. 
 

Here is a list of what was new in version 7 

      

 Toolbars 

 Complete overhaul of menu system to modern, XP style, breakaway toolbars. Toolbars are grouped 

according to function and may be placed anywhere - top, bottom, left, or right side or desktop. 
 All major functions are easily accessible with a single click. 

 User has control over which toolbars are visible and icons shown. 

 One click formatting of all grid columns - font, font size, font style, alignment, and colors. 

 Different toolbar layouts are supported for each named project. 

 Different grid layouts and formatting supported for each named project. 

 Select available windows from the new Window List. 
 
 

Script and Effect Manager 
 Columns can be re-ordered to your preference, simply by selecting the header and dragging to 

desired location. 

 32 named "Views" are supported for each Manager. A View is a Filter, a Sort, or a combination of 

both. 

 View, Filter, and Sort selection toolbars provide rapid access. 

 Unlimited number of Named and Storable filters. 

 Script and Effects Managers may be filtered by one or all columns. 

 Unlimited number of Named and Storable sorts. 

 Script and Effects Managers may be sorted by one or all columns, ascending or descending. 

 Single click, column sort available on toolbar for fast access. 

 Single click, Sort by Time for Script Manager, available on toolbar. 

 Single click, quick Filter by cell value available on toolbar. 

 Single Click, Unfiltered Cues. 
 Sort grid displays dynamically arranges columns by sort order. 

 Import and export Show Scripts, Cues and Effects easily. 

 Export effects from Script to new Effect Manager files. 

 Paste, Import Cues works now in multiple cue selection. 

 Copy-Cut-Paste text within cells. 

 Offset Cues, works now in Cues selections. 
 

Firing Tables Manager 

 New, integrated Firing Table Manager supports multiple Field Controllers. 

 Integrated Firing Table Manager consolidates all functions to create and download tables to 

Pyrodigital Field Controller on a single screen. 
 

WAVE Display 

 Improved control of WAV playback. Double-click to start playing. Single click left button to seek, 

single click right button to stop and seek. 
 

File Interface 

 Project Library. In this new menu you can see, select and copy all the project files to a new folder 

for filing or sending to another user. The project configurations , settings and file paths are saved. 
 Improved Script and Effect import and export to CSV format support. 

 Recent Project File list aids quickly opening up 5 most recent projects. 

 File open remembers your last directory. 

 Print all grids in WYSIWYG format, as displayed on screen. 

 File support and Plug-In ready for "Visual Show Director" fireworks simulation software. 
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Upgrading from 4.0: What was new in Show Director 5.0.5 

    
   Visual Show Director  includes all the features of Show Director 5.0.5.  Here is a list of what was new in version 5.0.5  
      
 

 Toolbars 

 Complete overhaul of menu system to modern, XP style, breakaway toolbars.  

 Toolbars are grouped according to function and may be placed anywhere – top, bottom, left, or 

right side or desktop. 

 All major functions are easily accessible with a single click. 

 User has control over which toolbars are visible and icons shown. 

 One click formatting of all grid columns – font, font size, font style, alignment, and colors. 

 Different toolbar layouts are supported for each named project. 

 Different grid layouts and formatting supported for each named project. 

 Select available windows from the new Window List. 
 
 

Script and Effect Manager 

 Columns can be re-ordered to your preference, simply by selecting the header and dragging to   

desired location. 

 32 named “Views” are supported for each Manager. A View is a Filter, a Sort, or a combination of 

both. 

 View, Filter, and Sort selection toolbars provide rapid access. 

 Unlimited number of Named and Storable filters. 

 Script and Effects Managers may be filtered by one or all columns. 

 Unlimited number of Named and Storable sorts. 

 Script and Effects Managers may be sorted by one or all columns, ascending or descending. 

 Single click, column sort available on toolbar for fast access. 

 Single click, Sort by Time for Script Manager, available on toolbar. 

 Single click, quick Filter by cell value available on toolbar. 

 Single Click, Unfiltered Cues. 

 Sort grid displays dynamically arranges columns by sort order. 

 Import and export Show Scripts, Cues and Effects easily. 

 Export effects from Script to new Effect Manager files. 

 Paste, Import Cues works now in multiple cue selection. 

 Copy-Cut-Paste text within cells. 

 Offset Cues, works now in Cues selections. 
 

Firing Tables Manager 

 New, integrated Firing Table Manager supports multiple Field Controllers. 

 Integrated Firing Table Manager consolidates all functions to create and download tables to 

Pyrodigital Field Controller on a single screen. 
 

WAVE Display 

 Improved control of WAV playback. Double-click to start playing. Single click left button to seek, 
single click right button to stop and seek. 
 

File Interface 

 Project Library. In this new menu you can see, select and copy all the project files to a new folder 

for filing or sending to another user. The project configurations , settings and file paths are saved. 

 Improved Script and Effect import and export to CSV format support. 

 Recent Project File list aids uickly opening up 5 most recent projects. 
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 File open remembers your last directory. 

 Print all grids in WYSIWYG format, as displayed on screen. 

 File support and Plug-In ready for “Visual Show Director” fireworks simulation software. 
 

Dongle Key 

 New USB and Parallel Port protection key, upgrade remotely. Demo version available. 
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Language Settings 
 

All the Visual Applications of Visual Show Director, are available in different languages. 

To select the language in use, please use the Language Selection Tool, available in the Visual 

Show Director folder as shown in the following illustration. 

 

 
 

The tool interface is very simple and it is enough to select a language from the ones available 

and press the [APPLY] button. 

The next time the visual tools are run, they will be in the desired language. 
 

 
 

Currently available languages: English, Spanish, Japanese, French. Korean, Chinese 

Simplified, Chinese Traditional. 
 

The text maps of language correspondences are located in:C:\Program Files 

(x86)\ShowDirector8\Visual\Resources\Messages 
 

 

 

If you are interested in correcting or translating Visual Show Director in your 

language, make any changes in the .txt files and send an email to 

vsd@infinityvisions.com 
 
 
 
 
 

  

mailto:showdirector@infinityvisions.com
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Show Director Overview 

WATCH VIDEO INTRODUCTION TO THE USER INTERFACE 
 

This is an overview of the files system structure of Visual Show Director  

It shows how all files are related and tied together in the Project. 
 

Download the Visual Show Director Files structure Map 
 
 

 
 
 
 
 
  

https://youtu.be/J-yOsjInjCc
http://www.infinityvisions.net/pdf/VSD_Map.pdf
http://www.infinityvisions.net/pdf/VSD_Map.pdf
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The Toolbars 

 

The tool bars let's you have all the commands conveniently accessible. They are fully 

customizable. 

The tool bars offer you quick access to the VSD functions and commands. It is VERY 

IMPORTANT that you take the time to go with your mouse over them to see what each one 

does. Click and try them. 
 

They are saved with the project. In this way when you reopen, everything will be in 

the exact place that you left it 
 

 Tool bar Features: 
 

o Can be placed anywhere in the Show Director window or in the Desktop. 
 

o Can be customized: Add or Remove Icons, Add Name tag to Icon, Icon size. 
 

o Function of the Icon is displayed when the mouse is over the icon. 

A tool tip always shows a description of the command 
 

o The toolbars position in the user interface are saved in the .atb file. Each project 

can have a specific tool bar layout or arrangement. 

If you want to use a toolbar layout as the default, copy the file 

"myproject.ToolBarLayout.atb" in the project folder where you made it and place 

it in C:/Users/"your username"/Appdata/Roaming/ShowDirector folder and 

rename it as "ToolBarLayout82.atb". After that in any new project it will be the 

default layout. 
 

o All the tools can be accessed from the Menus, so in order to save space in the 

screen you want to use only the most frequently used. This is the default original 

layout in the application. 

 
 

The available Toolbars 

 

file:///C:/Users/InfinityVisions%20A/Dropbox/INFINITY%20VISIONS%20SOFTWARE/HELP-VSD/HELP%20VSD845/movingtoolbars.html
file:///C:/Users/InfinityVisions%20A/Dropbox/INFINITY%20VISIONS%20SOFTWARE/HELP-VSD/HELP%20VSD845/movingtoolbars.html
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 Toolbar Features: 
 

o Can be placed anywhere in the Show Director window or in the Desktop.  
 

o Can be customized: Add or Remove Icons, Add Name tag to Icon, Icon size.  
 

o Function of the Icon is displayed when the mouse is over the icon. 

A tool-tip always shows a description of the command 
 
 

Toolbars Interaction 

 

Any Toolbar can be moved, docked in another place or left floating in the screen. 
 

 To move a tool bar, Drag & Drop it using the Handle shown in the next 

illustration 
 

 
 

 To close a floating tool bar, click on the X as shown in the next illustration 
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Toolbars Customization 
 

Any Toolbar can be customized with custom tools and it is also possible to create new custom 

toolbars to suit your needs. 
 

To show/hide a toolbar, right click with the mouse on 

an empty space of the toolbar and select from the popup 

menu shown in the next illustration the toolbar to 

show/hide. 
 

 
 
 

To customize toolbars,choose customize from the toolbars context menu. A new window 

with all the custom tools will popup. 
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Script and Effects Managers Common Tools 

 

 
The Script and Effects Manager share these common tools. 

 
 

Fonts Format tools

 
 

Sorts tools 

 
Ordered from left to right: 
 
Sort Script by Time (Ctrl-T)  Sorts the script by time. 

 
 
 
Sort Selection Ascending/Descending – Partial Selection Ascending Descending 

 
 
Additive Sort 

 
Adds another column to current sort. Clear Sort. 
 

Find Replace and Filter 

 
Universal Find/Replace in all the Managers. Shift+F3  
 

 
 
This function allows you to filter the results of searches of the "Find / Replace" tool 
 
1) Click where you want to search and filter 
2) Click on the icon Find / Replace tool or press SHIFT + F3 
3) The main window appears 
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4) Enter what you want to search  
5) Click on Find  
6) Click Filter to filter by the cell found 
 
 

Column Copy, Cut and Paste 

 
 
All ShowDirector Managers Grids are supported. It is limited to columns on the same grid and 

of the similar data types. Some data types can't be copied between columns (for example, 

while you can put a CUE number into a text field such as CUSTOM3, you can't put that 

CUSTOM3 value back into the CUE). 
 
Copy Column  Copies a selection in a Column. Select first cell and press Shift to select the last row of the 
selection. Click the icon of the tool. Copies data. 
 
Paste Column. Pastes copied data of the same format into another column. Select the cell  to insert copied 
data and press the icon tool. 
 
 

Quick Filter - Reset Filter - Unfiltered Rows 

 
 
Script and Effects QuickFilter are additive now. If you have a filter in place and select a new 

QuickFilter, it will add to the end of the existing filter. This continues until you select Reset 

Filter. 

 
Cross Filters    

 
 
This option can set filters in the Script Manager from a selection in the Effects Manager or in the Effect 
Manager from a selection in the Script Manager. 
 

1) In either the Script Manager or the Effect Manager, click on a cell in a column common to both. 

2) Press the 'Cross Filter' icon  

3) In the example below, the REF value in the Effect Manager is used to create a filter in the Script 
Manager 
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Visual Applications 

 

Visual Show Director integrates a set of applications that allow three dimensional creation 

and visualization of fireworks, special effects, lights and laser beams, image projections and 

movement of objects in a 3 Dimensional environment. 
 

Visual Show Director Multimedia Version is a complete fireworks and multimedia show 

authoring application that includes all of the above features not available in ShowDirector. 
 

 Visual Applications 
 

 FX Generator 

This application is used for the creation of the Effects and Libraries. 

click here for more information 
 

 3D Position Editor 

This application is used for the creation of Sites, Positions, Objects and Light Beams 

Keyframing animation . 

click here for more information 
 

 Producer 

This application is used to publish your show in a variety of picture and video formats, 

including stereoscopic images, and create VSDPlayer files 

click here for more information 
 

 Viewer 

This application is used to visualize your show in real time. 

click here for more information 
 

 
 

WATCH WHAT IS POSSIBLE 

 

  

http://www.infinityvisions.net/videos/CHAMPIONS2017VIDEO-desktop.m4v?_=1
http://www.infinityvisions.net/videos/CHAMPIONS2017VIDEO-desktop.m4v?_=1
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FX-Generator 

 

The FX Generator is the application used for the creation of the effects and Libraries of 

effects. 
 

With the FXGenerator you will produce Visual Reference codes that are associated with the 

effects in the Effect Manager and translated to the Visual Reference field in the Script 

Manager. 

This allows the Viewer to interpret and animate the effects. 
 

For complete details on the FX Generator , please refer to its User's Guide 
 
VIDEO TUTORIALS 
 
 
 

A Typical FX GENERATOR layout 
 

 
 
 

  

http://www.infinityvisions.net/Documentation/HELP-FXGEN/interface.html
https://www.youtube.com/playlist?list=PLHrFP1suMnXOnMIcymcKZyA1j_888mICN


VISUAL SHOW DIRECTOR 8 

21 / 137  

Producer 

 

The producer contains the functions to create snapshots, video and frames starting from a 

project file. The producer can generate media of any type from a script that can play 2D or 

3D shows, plus the option to create stereo or auto-stereo frames. 
 

The quality of the video is set by the Video Codec that you use and installed in your system. 

There are many packages of Video Codecs for download in the Internet. Choose a reliable 

one. 
 

For encoding the Audio in your system you need to run this Encoder. ( An error will appear if 

you do not have permissions to encode mp3) 
 

 Snapshots: the parameters are: 

o type of image file (.jpg, .pcx, .bmp, .tga); 

o destination filename; 

o Image quality and parameters (gamma correction, jpeg quality, etc etc.); 

o snapshot time; 

o flag for stereo or autostereo; 

o path in meters for the camera; 

o flag for alpha bitmaps; 
 
 

 Video: the parameters are: 

o Type of video files (.avi, .mpg, .wmv, etc etc.) 

o Destination filename; 

o Codec to use and codec options; 

o Sound flag; 

o Starting frame; 

o Ending frame; 

o "Take all the show" flag; 
 
 

 Frames: the parameters are: 

o Type of image file (.jpg, .pcx, .bmp, .tga); 

o Destination filename; 

o Image quality and parameters (gamma correction, jpeg quality, etc etc.); 

o Flag for stereo or auto-stereo; 

o Path in meters for the camera; 

o Flag for alpha bitmaps; 

o Starting frame; 

o Ending frame; 

o "Take all the show" flag; 
 
 

 Executable: the parameters are: 

o destination filename; 

o flag for playing the show in stereo mode; 

o path in meters for the camera; 

o starting frame; 

o ending frame; 

o take all the show" flag; 
 
 

For complete details on the PRODUCER , please refer to its User's Guide 
 
 
 

https://en.wikipedia.org/wiki/Video_codec
file:///C:/https:/www.dropbox.com/sh/g7yaqoy3jniwsug/AABqi_fJ0PYJCquDDJDflPOda/VSDProducer-fix-mp3-codec.cmd
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The PRODUCER interface 
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3D Position Editor 

 
 

The application is used to create position sites, generate light beam animation effects and 

animate 3dimensional objects. 
 

Library: shows the content of a position library; a library consists of a collection of sites; 

each site consist of a background filename (3d model: .3ds or bitmap file: .bmp, .jpg, or 

.tga), stage size and square size factor, sky and terrain bitmap filenames, etc. 
 

Object Hierarchy: this panel shows the object hierarchy tree, i.e. a tree that shows the 

relationship between the several objects inside a site. 
 

Position Grids: this panel shows, for each site, the positions like a database, so the user 

can modify positions coordinates and attributes by typing in this grids. 
 

Key-framing: this panel shows a time line that can be used to establish an animation for a 

beam or for an object. 
 

Tool Options: this panel shows all the options relative to a particular tool; 
 

Groups and Selections: this panel shows the tools relative to group of positions. 

If you are using Visual and don't want to have all the positions listed you can create a group 

of positions in the 3D Position Editor. Then use @groupname in the cue. It will fire from all 

the positions in the group. Obviously for the addressing and set up you have to paste all the 

positions in that @ cue. If you made an empty script with all the positions in the groups, use 

Import Cues to paste them, and then fill down the parameters of the cue and the REF for 

inserting same effects. 
 

For complete details in the 3D POSITION EDITOR , please refer to its User's Guide 
 
VIDEO TUTORIALS 
 
 
 

A Typical 3D POSITION EDITOR layout 
 

 

http://www.infinityvisions.net/Documentation/HELP-3DPOS/default.html
https://www.youtube.com/playlist?list=PLHrFP1suMnXM0wHUMRUp-JNcwsQaQMCBj
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Viewer 

 
 

The Viewer is the component that visually plays a show. The component works in window 

mode. 
 

Window mode: the component runs in a window, and the controls (play, stop, etc.) are 

outside the Viewer and shared with Show Director. 

The options are customizable. 
 

The Viewer application automatically recognizes any change of time in the wave file while in 

play and it is automatically synchronized. 

 

IF AND ONLY IF YOU ARE USING EXTERNAL TIMECODE, INSTEAD OF A WAVE FILE, 

YOU NEED TO PRESS THE  BUTTON ON THE VIEWER TOOLBAR TO INITIALIZE THE 

VIEWER WITH THE ACTUAL TIMECODE. 
 

Notes about the Viewer Interaction with external time-code 

When using an external time-code source, such as Pyrodigital Modem, the Viewer waits for 

the time-code Sync button  and then keeps going using an internal clock to save 

resources. 

Only if you change your time-code (i.e. using FFW or REW), then you need to press the Sync 

button  once again to tell the application the new time it have to reinitialize the internal 

clock. 
 

Interface 
 

The Viewer main interface looks like this: 
 

 
 

The main window features a main display area, plus a toolbar to customize options and a 

status bar to display information about the application. 
 



VISUAL SHOW DIRECTOR 8 

25 / 137  

 
 

The Viewer Keyboard controls 
 

Up – Down – Left - Right 

Camera Movement 

 Zoom In - Zoom Out 

Camera Zoom 

Rotate 

Camera Rotation 

 
 
 

The Toolbars 

 
The tool bar contains the commands to change camera position and orientation and the 

rendering options. 
 

 Available Tools 

o  Show/Hide position dots: 

this tool toggles the visibility of position markers, displayed as green dots on the 

screen; 
 

o  Show/Hide burst rise: 

this tool toggles the visibility of the burst rise; the burst rise is the dot that appears 

when a shell is shot from a position; 
 

o  Reset Camera: 

this tool resets the camera to the default position and orientation; 
 

o  Make Snapshot: 

this tool captures a snapshot of the actual view-port and saves it on file; 
 

o  Options: 

this tool brings up the Option window where advanced customization is possible. 
 

 
 
 

 



VISUAL SHOW DIRECTOR 8 

26 / 137  

The Status Bar 

 
The Status Bar displays information about the number of particles used to display the actual 

scene and information about the windows size (useful when taking snapshots). 

 Notes about the Number of Particles The number of particles panels displays a 

counter indicating how many particles are active on the screen. 

The higher the number of particles, the more system resources are used. Please keep in mind 

this equation when designing effects in the FX Generator. 

The number of particles depends on the way each star type has been built (a star with tail is 

made by several particles). 
 
 
 
 

Options 

 
 

The Viewer Option Window looks like the following illustration: 
 

 
 

This window is organized in sections for an intuitive navigation 

 General Options 

The General Options section panel includes the common options used to show/hide objects 

like positions, sky and terrain that are related to each site. 

The option also includes the random rotation for shells, which makes the shells rotation 

random as in the real world. 
 

 Rendering 

The Rendering Options section is related to the actual render used and includes: 

o Filtering: this option makes the pictures applied to polygons more smooth; if you 

disable this option, the pictures will be more sharp; disabling this option results in a 

faster rendering. 
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o Mip-mapping: this option reduces pictures size depending on the distance from 

camera; disabling this option results in a faster rendering. 

o Enable light: this option enables lighting on the environment; when disabled, the 

engine renders all the polygons with the same light; disabling this option result in a 

faster rendering 

o Position dot size: this option sets the size for the dot used to display the positions on 

screen; the size is expressed in centimeters. 

o Sound Effects: The Sound Effects options section includes a check-box to toggle 

sounds on/off. Sound volume can be adjusted using the +/- buttons 

o Interface: the Interface section includes the FOV (Field Of View), expressed in 

degrees, and the height variation used to add that little touch of inaccuracy typical of 

the real world displays. 

This section includes also the mouse sensitivity factor, adjustable using the +/- buttons 

which establishes the relation between mouse movements and camera: the higher this 

is set, the faster the camera movement (for very accurate movements, set this value to 

a low number). 

o Wind options: The wind options includes the wind force and angle; the angle 

establishes the wind direction, in a clockwise convention 

o Window and Misc options: The Window and Misc options includes the actual window 

size and the parameters related to stereographic pictures. 

With the “Stereo Picture Width and “Stereo Picture Height, it is possible to set the size 

for the stereo picture; 

with the “Path in Meters it is possible to set the distance from the two cameras used to 

produce a stereographic image. 
 

At this point, it is possible to create a standard stereo picture using the “Make Stereo 

Picture button or to create an auto stereo picture with the “Make Auto Stereo Picture 

button. 

The stereo picture will contain two pictures: one of them represents a snapshot from 

the actual position of the camera minus the (path in meters)/2, and the other 

represents a snapshot from the actual position of the camera plus the (path in 

meters)/2. 

The auto stereo picture will contain 9 pictures: the 9 pictures are placed in a 3x3 grid, 

and each of them represents a snapshot from the actual position of the camera that 

stands on the path. 

o Particle Engine Properties: The Particle Engine Properties panel contains options to 

customize the maximum number of head and tail particles that the engine will use to 

draw particles. 

This option shows the memory size consumption for the selected particles; to update 

this value use the "Update Value" button. 
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Grid Formatting Layouts 

 

It is possible to customize the grids appearance for each project using the [FORMAT] menu 

and tool-bar. 

All the changes to the grid are saved in the project folder with the filename 

[projectname.gridlayout.grx] and are automatically restored on project opening. 
 
 

The Format Menu and the Formatting tool-bar 
 
 

WATCH VIDEO Configure your own User Interface: Windows Tiling and Layouts. 
 
 

    
 
 
 

  

http://www.infinityvisions.net/videos/windows_tiling_layouts.mp4?_=9
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Grid Formatting by Columns 

 

To assign a certain format property to a column: 
 

 Select the column/s clicking on the column/s header 
 

 Change the format option from the Format Menu or from the Formatting Toolbar. 
 
 

If you want to change the name of a column,right click in the tag of the column and a 

dialog will prompt you to change the names. 
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Hide / Show Columns 

 

Any column can be hidden or un hidden in a grid layout. 

With this feature, Show Director allows the user to work with a subset of the columns for a 

better organization 
 

To Hide one or more columns 

1. Select the columns using the columns headers 

2. click on the closed eyes icon  in the [FORMATTING] toolbar 

or select  from the [FORMAT] menu 
 
 

To Show one or more columns 

1. Select the columns using the columns headers 

2. click on the closed eyes icon  in the [FORMATTING] toolbar 

or select  from the [FORMAT] menu 

3. Select the columns you want to show again in the dialog that pops up (see next 

illustration) 
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Repositioning Columns 

 

Columns positions are customizable in Show Director 
 

To change the position of a column in the grid layout 
 

1. Select the column using the columns headers 

2. Drag it to the desired position. A RED marker shows the insert point while dragging 

3. Drop it in the new position 
 
 

 
 
 

All the changes are displayed immediately and saved with the grid layout file. 
 

Custom Views 

 

We have the ability to save a named Custom View that includes the Visible Script Columns 

and their order plus whatever filters or sorts you may have in place.  
  

These Custom Views can be used in any project without having to load the original Script 

Filter or Sort files.  
 

In addition to loading a Custom View, you have the ability to Print or Save the Script using 

that View.   

Saving uses the Microsoft Excel format (.xls) and only saves the visible columns in order with 

the filter and sort.   
 

This differs from normal Script Save as Excel which saves ALL columns and data.   

Use this feature to create Custom Reports that can be applied to any Project.   
 

A few commonly requested Custom Report Views have been included to get you started.  
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\

 

 

Layouts 

 

The Layouts are the best way to customize the user's visual interface to any firing 

system. 
 

Saving and Loading of the layout files is done from a new Grid Options dialog.  
 

Make any changes in the view of the grid: Rearrange columns, hide or show columns, change 

fonts and backgrounds. 
 

To save or load a grid layout, select the grid and press F11.  
 

Saving your grid layout will save:  

 The foreground and background colors  

 Fonts 

 Columns shown (Hide/show) 

 Column order and column width  
 

Loading will restore these values. Each type of grid (Script manager, Script Filter manager, 

etc.) has its own layout file format and its file extension will be that of its grid + 'l'.  
 

For example, the Script manger's extension is '.scx' and its layout file extension is '.scxl'.  
 

Each layout file contains the layout for only one grid type.  
 

Layout files are not Project specific so you can load your layouts on any grid in any 

project.  
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Option to save or load all grid layouts at once.  Select from the menu Window->Window Layouts.  The 
Layouts dialog will appear where you can select what loaded grids to configure and either Save or 
Load those layout files. 

 

 
 

Fixing problem of blank grid in Script or Effects Manager 
 

By clicking Factory Reset Grid Layouts allows all of a projects layout files to be returned to factory 
defaults. 
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The Creation Process 

 

The Project 

 

The creation of a Project (.pyr) is the first step to design a show. 
 

The Project contains: 

Two files for the appearance and display of the Grid and Tool bars. 

 (.GRX) The Grid Preferences set for field colors, fonts, column display and position, 

 (.ATB) The Toolbars settings for their display or not and position in the window 

These files are created automatically when the project is saved according to the configuration 

that the user has made. 

The files can be renamed in another project with the new project name and this will adopt the 

configuration that they contain. 
 

The Project contains and associates a group of files necessary to display a show: The 

following files must be created or selected in this order to use the software. 

 Wave File (.WAV) 

Contains the music of the show to synchronize with cues. 

 Script Manager (.SCX) 

Contains the Cues and associated Effects characteristics, Positions, Worlds, Firing addresses. 

 Visual Script (.CHR) 

Contains a exported version of the Script used by the Viewer to run the simulation of the 

show. 

 Effects Manager (.EFX) 

Contains the Effects with all the parameters necessary to be inserted in the cues of the Script 

Manager. 

 Position File (.POS) 

Contains the Site positions. Created with the 3D Position Editor application. 

 Library (.LIB) 

Contains the Library of effects. Created with the FX Generator application. 
 
 

The Project can also contain optional files not necessary to display a show but useful for the 

operation of the Script Manager and Effects Manager: 

 Script Filters (.SFR) 

Contains a table of custom filters set by the user, to filter the Script in different ways and to 

split the Script into various down-loadable tables to the Field Controller, and to Export the 

cues according to the Filter selected. 

 Script Sorts (.SSR) 

Contains a table of custom Sorts set by the user, to sort the Script in different ways. 

 Effects Filters (.EFR) 

Contains a table of custom filters set by the user, to filter the Effects Manager in different 

ways. 

 Effects Sorts (.ESR) 

Contains a table of custom sorts set by the user, to sort the Effects Manager in different ways 

and to Export the cues according to the Filter selected. 
 
 

Script and Effects Filters and Sorts can be associated in the Script or Effect View tool bar to 

create a view that combines a filtered Script Manager or Effect Manager sorted in a specific 

way. 

For complete details in the VISUAL APPLICATIONS , please refer to their own User's Guide 

or, 

READ THE INSTRUCTIONS FOR A QUICK START GUIDE 
 

file:///C:/Users/an/Dropbox/INFINITY%20VISIONS%20SOFTWARE/HELP-VSD/VisualShowDirector%208%20Quick%20Start%20Guide
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Software User Folders Structure 

 

It is recommended to create and maintain a logical folder structure that can be 

shared with other users within a company and to store orderly the production show 

files. 
 

You can start by using the same root drive C: or D: 
 

In C: or any drive, create a root folder for the Visual Show Director software files. 

The following is just an example. You decide what kind of order is best for you. 
 

Example: 
 

 
 
 

There will be common files used in every project: Effects Manager, Visual Libraries, 

Sorts and Filters, Custom Reports, Layouts, Sites, Music,  that can be located in 

dedicated folders as common shared resources. 
 

If you create a Template project that will always open these common files, you will 

need to add only Script and Wave, most likely. 
 

In each specific project there will be files corresponding more exclusively to the project like: 

Scripts,Sites, Reports...  
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The Project 

 

The Project File 
 

Show Director stores all information in Project files (.pyr). Project files linking the group of 

files necessary to conduct the operation of show scripting and downloading to the Field 

Controllers.  
 

You must always start by creating a Project, with the command New Project. If you 

choose to not create a Project, you won't be able to save settings and layouts and 

will be forced to open every time the group of files again. 
 
 

Download the Visual Show Director Files structure Map 

 

Create a New Project 

 

Start by creating a Project, with the command File Menu> New Project or press (Ctrl+N). 
    

By creating a Project(.pyr) all of the necessary files for show design will be grouped together 

and opened automatically each time the project is opened. If you choose not to create a 

Project, you won't be able to save settings and will be forced to open the group of files 

individually. 
 

Once the Project is created you have to continue opening existing or creating new files in 

order for them to be grouped:  

From the File Menu Create New: 
 

Script Manager (.scx). 

This is the window for scripting, containing the time-line and all the information of the show. 

(create new, or open existing) 
 

Effects Manager (.efx). 

This is the window that contains your Database of Effects. You will insert effects or drag them 

from this window into the Script. With this file it is NOT necessary to re-type effects in the 

Script Manager every time you make an entry, if they are previously stored with all their 

characteristics in the Effects Manager. You can have as many Effects Manager databases as 

you want. 
 

Wave Display (.wav). 

This is the window that displays your music in the form of a PCM WAV file. You will navigate 

through the Script and Music clicking on this display. 

You will be able to insert cues or effects directly from here, and see a display of marks of 

them in the wave display. The resolution of the display is adjustable. WITHOUT a .wav file, 

cuing in times using cue function will not be possible as there is no reference of time without 

the WAV.  
 

Sorts & Filters: Files that you create to change the view, organize, or arrange a Script 

Manager(.scx) or Effects Manager(.efr) file. The purpose of using Sorts & Filters is to quickly 

access and organize the vast amount of information contained in your show files. Create a 

Filter and then enter in what parameters it will use to search, arrange, show or hide certain 

data.  
 

Script Filter Manager (.sfr). 

this window contains all possible Filter combinations for all columns that you create. This file 

file:///C:/Users/InfinityVisions%20A/Dropbox/INFINITY%20VISIONS%20SOFTWARE/HELP-VSD/HELP%20VSD845/newproject.html
http://www.infinityvisions.net/pdf/VSD_Map.pdf
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can be opened in multiple Projects, saving once in order to use your preferred filters at any 

time. This window or control panel serves to create the Table files that will be downloaded to 

the Field Controller. You can assign to each filter a Field Controller ID (serial number) and a 

Firing Table ID. There is a Function to see the Unfiltered Cue, to avoid miss-download of firing 

data.  
 

Script Sort Manager (.ssr). It contains allows you to create all possible combinations to 

arrange the columns and rows. This file can be opened in multiple Projects, saving once in 

order to use your preferred Sorts at any time. For example, arrange by Position, Effect, 

Duration, Caliber. etc 
 

Effects Filter Manager (.efr). 

This window contains all possible Effect Filter combinations for all columns that you create. 

This file can be opened in multiple Projects, saving once in order to use your preferred Filters 

at any time 
 

Effects Sort Manager (.esr). 

This window contains all possible Effect Sort combinations for all columns that you create. 

This file can be opened in multiple Projects, saving once in order to use your preferred Sorts 

at any time. 
 

Visual Script File (.chr) 

Creates with a predetermined (given) name, normally the same as the Script Manager. This 

is an exported version of the Script in .chr format used by the Viewer to run the simulation of 

the show. The Export can be done by pressing the Icon with the yellow and black nuclear sign 

on it. 
 

Visual Position File (.pos) 

Selects the Site positions. This file must be previously created with the 3D Position Editor 

application accessed from the Tool bar. 
 

Visual Library File (.lib) 

Selects the Library of effects. The file must be previously created with the FX Generator 

application accessed from the Tool bar. 
 
 
 

If one or more of these files are missing, it will be impossible to start the viewer and the 

system will warn you of the missing files. 
 

Two new files that are created automatically in every Project are added to the 

group of files in the Project. You should not delete or move these files: 

 GRIDLAYOUT (.grx) 

This file stores the configurations that you give to the Grids. In Show Director you can move 

and swap the order of the columns and hide them. 

 TOOLBARLAYOUT (.atb). 

This file stores the layout of the new toolbars configuration and position in the window. 

Every project can have different layout and configuration. Show Director will create a specific 

GRIDLAYOUT (.grx) and TOOLBARLAYOUT (.atb), for every project. In the case that you do 

not choose to work within a project, Show Director will create two default files. 
 

Download the Visual Show Director Files structure Map 
 

 
 

 

 

http://www.infinityvisions.net/pdf/VSD_Map.pdf
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Open an Existing project 

 
 

 
 

It is only possible to have one project open at a time. If you open another project the current 

one on screen will close. Changes are automatically saved. If you want to compare Projects 

or Scripts you can launch the application as many times as necessary (conditioned to RAM 

capacity) , multiple Show Director windows can be open at one time.  
 

When Show Director starts and you open a New Project, it will open with the default 

configuration: all columns, black foreground and white background, MS Sans Serif 8 font. If 

you open a new project with another one already open, the new project will adopt the screen 

configuration of the existing one and will replace it.  
 

The Script and Effects Manager files will be the same as the previous project. Filters, sort and 

download configuration will be the same. To open a project use the File Menu as shown in the 

following illustration or the predefined shortcut CTRL-O. 
 
You can star by opening  the DEMO PROJECT and put the files folder in C:SHOWDIRECTOR 
 
 

  

http://www.infinityvisions.net/DEMOS/2019DEMOLIB.zip
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Save a Project  

 

There are two ways to save a project. 
 

Save Project: saves the Project and settings for the Grid and Toolbars and links to 

associated files. 
 
 

Save As:  saves the project with a different name, it is useful when you want to create a 

new project with the same settings as the original.  

You may want to close and open new Script or other files. 
 
 
 

 
 
 
 

Close a Project 

 

File Menu > Close Project 
 

 
 
 

This command closes the Project and associated files. It frees the memory to open a new 

Project without having the configuration of the previous Project. 
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The Project Library 

 

File Menu > Project Library (Ctrl+L) 
 

 
 

This command opens a new window, where you can see all the files associated with the 

Project, and their relative paths. 
 

You can Export these files packed, to a new Project, into a different directory or folder of the 

original project. 
 

This folder can be exchanged and when the exported Project opens in a different computer it 

will keep the same layout configuration and file paths. 
 

To export a Project the Project must be closed in order to be able to read and write new files. 

Close the Project and Browse for it and then proceed to export. 
 
 

For visual projects, exporting from the project library also exports textures and data for 3D 

models as needed. 

In some cases the exporting of Sketchup models needs to be done manually copying from the 

model folder. If you get an error message, uncheck the Visual Positions and proceed 

manually. 
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  Import Project 

Will import a previous version project into version 8 in a different new folder. 
 

 "Write File List" 

Will create a .txt document in the same folder of the project (.pyr), with the list of files and 

paths. You can use this file to create a printed record of the Project files. 
 

 "Export Project" 

Will export a project with all its files in a specified folder. This function is useful to share 

projects and to have portable copies.Will export a project in Show Director previous versions 

file formats.  
 

 
 

 "Producer" 

Will launch the Producer to render the visual project to a movie or picture format 
 
 
 
 

  



VISUAL SHOW DIRECTOR 8 

42 / 137  

The Wave file 

 

The Wave Display Window is the preferred way to script a show. You should be able to create 

your soundtrack with a number of sound editors available on the market. Show Director plays 

16bit wave format. Wave Files made at 32 bit will need to be converted to 16bit. 

 

If you play the soundtrack from a .wav file, you will need to include time code in 

synchronization with the wave clock. You can record time code from the Pyrodigital CD, the 

time code starts at 00:00:00:00. If you are importing audio time code from the PD CD, do 

not delete the tone at the beginning; it is part of the Time Code sequence. 

From the .wav file with music and Time Code you can record your final show tape or vice 

versa. 

 The ability to display and script to the music's waveform image is now provided using 

the WAV file display window. This display overlays the cues onto the WAV display, and 

indicates each cue's caliber graphically with higher caliber being taller on the WAV display. 
 

 The user has the ability to position the time cursor and add cues and effects using the 

WAV display, in addition to the normal "space bar"” capture. 
 

 The display appearance can be user defined under the Configure Menu- Wave Display. 

You can select a .wav file to script. 
 

File Menu > Wave File 

 
 

   
 
 
 
 
 

Before you open a wave file and want to see the graphics, make sure that you have 

WAV Plot Display Enabled in the Configure Menu: Wave Display 
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Working Sequence: 
 

1. Open Wave File Menu, select a wave file to play. Click Open in the Menu 

2. The Process WAVE file window will be displayed. You can select left or right channel, if 

you have a channel in your wave with the Time Code. 
 

It is possible to increase the definition of the graphic display reducing the file size factor. The 

graphic plot file size is by default 500 KB. The factor is set automatically to create a plot file 

of this size. Bigger sizes of graphic plot file, will give more definition and also may slow the 

display. Same size of Plot and Wave File is factor 1. 
 

Channel selector allows selecting Left or right channels of your wave file. This is necessary 

when you have a wave file that also has Time Code in one channel. To not plot the Time Code 

Channel you will have to select the Music channel. The computer will play a wave file as is, in 

stereo. To not hear the Time Code you will have to disable the channel with the Windows 

audio settings for balance. 
 
 

 
 
 
 

Once the process of building the plot file is finished the new Wave Window will pop up and 

will be synchronized with the Script.  

The cues and caliber will also be plotted over the wave graphic. 
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The commands in the Wave display window allow you to: 
 

 Zoom In and Zoom Out (16 magnification steps) Small Scroll Left and Right Large 

Scroll Left and Right Add a Cue pressing the Add Cue button or depressing the Space Bar Add 

a Cue with a selected effect or effects in the Effects Manager while capturing. Visualize 

Marked cues and caliber of effects Double click in any part of the wave graphic starts playing 

the sound and re-locates the cue in the Script Manager Select a Cue or row in the Script 

Manager places the Wave Cursor in the corresponding time position. 
 

 To PLAY the music you can double click anywhere and the Script will locate the cue 

and start playing and displaying the Events. 
 

 If you are searching for a beat in the music, after locating it, you can use the right 

button of the mouse to start play and stop in the same position. 
 

Multi-Select using Shift-Click on the Wave Plot will Select multiple cues. 
 
When the Wave Plot is in Capture mode (i.e. "Green Light"), if you click on the wave plot it selects the next 
nearest cue.   
Now if you Shift+Click further along the wave plot, it will multi-select all the cues between the two clicks. 
 
 

Move Left and Right using  SCROLL 

 

With the WAV window selected, scroll the Mouse Wheel to scroll the wave display left or 
right. 

 
  
Zoom Using SCROLL 

 

With the WAV window selected, Shift+Mouse Wheel to zoom in or out from the selected 
mark. 
 

 
  
Copying and Moving Cues on the Wav  
 

This new tool allows you to move and copy Cues in the audio line in a very fast way. 
1) Select the cues you want to move or copy. You can select multiple cues by 
clicking the first and last cue with the SHIFT key. 
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2) CTRL + Click on the audio line where you want to move or copy the Cues  
3) Select whether you want to move or copy the Cues 
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The Visual Files 

 

In order to play a show in the Viewer, Visual Show Director needs to have a set of 3 files. 
 

 
 

 A Visual Script File (.chr) 

Creates with a given name, normally the same as the Script, an exported version of the 

Script in .chr format used by the Viewer to run the simulation of the show. The file needs to 

be Exported by pressing the Icon with the yellow and black nuclear sign on it. 
 

 
 

 A Visual Position File (.pos) 

Selects the Site positions. The file must be previously created with the 3D Position Editor 

application. 
 

 A Visual Library File (.lib) 

Selects the Library of effects. The file must be previously created with the FX Generator 

application. 
 
 

If one or more of these files are missing, it will be impossible to start the Viewer and the 

system will warn you of the missing files. 
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The Script File 

 

The Script File (.scx) is where you create your show cues and contains all the information for 

the show. 
The functions that apply to the Script are in the Cues Menu. See the chapter Working with Cues 
 

The Script window has the following columns names and characteristics: 
 

* This is not a representation of the script, but a LIST of the variables in the Script. 

You can reorder the position of the columns and have them visible  or hidden from the 

interface. 

Columns names can be changed in the Columns: Locks 1 to 8 and Custom6,7 and 8. 

 

Data Field Formats 
 
 

* When importing from .xls or .csv the number of characters will be trimmed to match Show 

Director maximums. 

 

Column Column Name Column Data 
Type 

Comment 

1 CUE  Number(5) Unique id for a script row. 

2 MACRO  Number(5) A number that links shots together for a single firing sequence. 
Event in Fireone. 

3 GROUP  Text(48) Name of a group of effects. 

4 TABLE  Text(32) Description to split the script into subscripts. 

5 MODE  Text(32) MANUAL, MUSIC, AUTO or GPS. 

6 TIME Number(8) Long value for PCM time. 

7 HH  Number(2) Integer value for cue hours. 

8 MM  Number(2) Integer value for cue minutes. 

9 SS  Number(2) Integer value for cue seconds. 

10 FF  Number(2) Integer value for cue frames (default 0-29) 

11 MS  Number(7) Long value for total number of milliseconds represented by cue 

time. 

12 NEXT  Text(8) MM:SS:FF until the next cue. 

13 Event Description  Text(128) Open description of the event in the  cue. 

14 PFT  Number(5) Pre-fire time in milliseconds. 

15 ADDR  Number(3) Hex value for the Pyrodigital HEX address. 

16 CONTROL  Text(32) Name of the field controller or system for this cue. 

file:///C:/Users/InfinityVisions%20A/Dropbox/INFINITY%20VISIONS%20SOFTWARE/HELP-VSD/HELP%20VSD845/workingwithcues.html
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17 MODULE  Number(4) Integer address for a module (0-9999) 

18 PIN  Number(4) Integer address for the pin on the module (0-9999) 

19 CGHZ  Number(2) Integer 1-99 for Caliber hazard groups. 

20 LOCK1  Text(10) Open lock description string. Character "X" activates lock. 

21 LOCK2  Text(10) Open lock description string. Character "X" activates lock. 

22 LOCK3  Text(10) Open lock description string. Character "X" activates lock. 

23 LOCK4  Text(10) Open lock description string. Character "X" activates lock. 

24 LOCK5  Text(10) Open lock description string. Character "X" activates lock. 

25 LOCK6  Text(10) Open lock description string. Character "X" activates lock. 

26 LOCK7  Text(10) Open lock description string. Character "X" activates lock. 

27 LOCK8  Text(10) Open lock description string. Character "X" activates lock. 

28 POS  Text(10) Firing  position. Alphanumeric. 

29 ANGLE  Text(64) Angle is open text and may include numbers and \|/. 

30 QTY  Number(4) Integer for number of effects on this cue. 

31 CAL  Number(3) Integer value for the caliber of these effects in mm. 

32 TYPE  Text(36) Text description of the kind or family of effect being fired. 

33 DUR  Number(4) Integer effect duration in (0-99) seconds  and (0-29) frames 

(00:15 = 1/2 sec). 

34 Effect Description  Text(128) Description of the effect. Color, etc. 

35 REF  Text(50) Reference number for the effect. 

36 MFG  Text(64) Manufacturer of the effect. 

37 MAGAZINE  Text(6) Inventory Quantities. Inventory-tracking. 

38 PRICE1  Number(8) Price of this effect. 

39 PRICE2  Number(8) Price of this effect. 

40 PRICE3  Number(8) Price of this effect. 

41 CUSTOM1  Text(128) Open text field for effects data. Header right click to change. 

42 CUSTOM2  Text(128) Open text field for effects data. Header right click to change. 

43 CUSTOM3  Text(128) Open text field for effects data. Header right click to change. 

44 CUSTOM4  Text(128) Open text field for effects data. Header right click to change. 

45 CUSTOM5  Text(128) Open text field for effects data. Header right click to change. 

46 CUSTOM6  Text(128) Open text field for script data. Header right click to change. 

47 CUSTOM7  Text(128) Open text field for script data. Header right click to change. 
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48 CUSTOM8  Text(128) Open text field for script data. Header right click to change. 

49 PAN  Number(255) Angle number value to describe PAN direction of trajectory 
.Multiple separated by " - " 

50 TILT  Number(255) Angle number value to describe TILT direction of trajectory 
.Multiple separated by " - " 

51 CAMERA  Text(255) Text field to describe the camera FOV. Captured from Viewer. "c" 

key. 

52 VISUALREFERENCE  Text(255) Text field to describe the code of the particle effect. Fx Generator. 

53 BEAM  Text(255) Keyframing string for animation of lights and lasers. 3D POS 

EDITOR. 

54 WORLD  Text(64) Text name of a site in the .pos project environment.3D POS 
EDITOR. 

55 OBJECT  Text(255) Keyframing string for animation of an object in the 3d 
environment. 

56 PICTURELINK  Text(255) Text link to PLAY a web or disk based picture. 

57 VIDEOLINK  Text(255) Text link to PLAY a web or disk based video. 

  

 

Rename Columns 

 

The Columns CUSTOM 1-2-3-4-5 and LOCKS 1-2-3-4-5-6-7-8 can be renamed with your own names. 
Right Click in the Header of the column and do it the Form to Change name. Different names templates 

can be saved and applied to new projects. 
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Create a New Script File 

 

File Menu > Script File > New 

 
 
 

Creates a new Script file. 

The user is prompted for a valid filename and, if the selected filename corresponds to an 

existing file, the software warns the user and prompts for overwrite. 

It is safe to press [NO] if the user doesn't want to overwrite the existing file. 
 

Open an existing Script File 

 

File Menu > Script File > Open 

 
 

Opens an existing Script file. 

If the file that is being opened is from a previous version of Show Director, the software will 

warn the user and will prompt for a filename for the imported version. 

It auto-updates the file format. 

Save Copies of the Script File 
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Save As, saves a copy of the open File. 

It is useful to frequently save backups of your file. 

The current Script will close momentarily while saving and reopen. 

SAVE AS: ,scx version 6/7, .xls , .csv , .efx 
 
 

Save the current Script File as an Effects Manager 
 

You can create an Effects Manager from all the effects present in the Script. Just select 

Effects Manager File in the Save As form. 
 

 
 

Note: There is no [SAVE] command on Script as this is saved constantly every time a change 

is made 

 

Auto Restore - Undo 

 

 New Auto Restore for Scripts and Effects Managers. This new function will keep a back 

up of your most recent Scripts or Effects Managers making a copy of the files every 5 

minutes within 1 hour. There will be 12 copies that you can restore at any point on 

time.  
 

 The feature is only active with a project open. The backup files are stored in a folder 

inside the directory where the project is saved.The function can be manually 

deactivated by changing On to Off in the file sd.ini in 

C:/Users/username/Appdata/Roaming/ShowDirector. You will never loose more than 5 

minutes of work. 
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Import a Script File from other Firing Systems 

 

Imports a file from  Fireone (*.fir), Galaxis (*.gs2), Pyroleda (*.shw), Explo(*.shw), Cobra 

and fireTEK (* .csv) 
 

The column order and configuration is the same as in Show Director Script.  
 

 
 
 
 

Finale 2D Script 
 

1) In Finale 2D click on the File menu 

2) Click on Export CSV show as Generic File 

3) Click on ASCII encoding 

4) Click on Export 

5) Click on Skip Music 

6) Assign a name and save it. 
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Export a Script to other systems 

 

Exports a file to Fireone (*.fir), Galaxis (*.gs2), Pyroleda (*.shw), Explo(*.shw), Cobra, 

FIREMASTER, Ratel,  fireTEK (* .csv), Piromac. 
 

The column order and configuration is the same as in Show Director Script.  
 

If you want to export All Columns, you need to use the File Menu function "Save As> Excel. 

xls, or .csv" 
 

 

 
Export to GALAXIS™ Format. Download: 
http://www.infinityvisions.net/Documentation/GalaxisVSDExport.xlsx 
 

  

http://www.infinityvisions.net/Documentation/GalaxisVSDExport.xlsx
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FireOne Columns Correspondence (.xls) 
 

FireOne F1 Type VSD Column Comment 

ID AutoIncrementing  AutoIncrementing - NOT CUE, CUE IS 
LOST 

ScriptTime float   

Position Char(10) POS DATA LOSS 64 -> 10 

Qty small int QTY  

BreakTime float   

Duration float DUR  

Priority small int CGHZ Defaults to '1' else CGHZ 

Cost BCD PRICE1  

Location Char(8) POS DATA LOSS 64 -> 8 

Comment Char(60) Event Description DATA LOSS 128 -> 60 

LaunchTime float   

Description Char(80) Effect Description DATA LOSS 128 -> 80 

ProductNumber Char(20) REF DATA LOSS 50 -> 20 

Size Char(12) CAL DATA CONVERSION  Int -> string 

Color Char(14)   

VendorNumber Char(20) MFG DATA LOSS 64 -> 20 

Type Char(15) TYPE DATA LOSS 36 -> 15 

ScriptTimeMS int MS  

LaunchTimeMS int MS - PFT  

DelayTimeMS int  Hardcoded to '0' 

ScriptTimeText Char(14) MS  

LaunchTimeText Char(14) MS - PFT  

DelayTimeText Char(14)  Hardcoded to "00:00:00.00" 

Effects Char(6) ANGLE DATA LOSS 64 -> 6 

Event small int MACRO  

Slat int MODULE  

Cue int PIN  

Length Int   

SayWhen int   

SayWhenText Char(14)   

SayWhat Char(50)   

Conflict Char(10)   

PyroSlat Char(4)   

PyroCue Char(2)   
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GALAXIS 
 
http://www.infinityvisions.net/Documentation/GalaxisVSDExport.xlsx 
 
 
 
field - 
Versio
n 2 

Galaxis 
Name 

your 
interpretatio

n 

Prefered 
Galaxis 
Name 

VSD Column Comment Value Sample Sampl
e 

Sampl
e 

Sample Description 

(Field 
#0)  

Ignition 
time 
count 

0 Cue CUE starting with 1  1 - 999     Cue 1 starts 
normally at 
00:00:00, if the 
ignition time is the 
same we have the 
same cue number 

(Field 
#1)  

Dt 1 dt NEXT as an integer 
representatio
n of 1/100 
seconds  

0 - 99990 0,91s = 
91 

2,10s = 
210 

   

(Field 
#2)  

Ignition 
time 

2 Fire Time MS - PFT as an integer 
representatio
n of 1/100 
seconds 

0 -  3:55:49 = 
35594 

2:53:0
4 = 
25304 

9:57:7
5 = 
95775 

10:03:88 
= 100388 

the whole script is 
sorted by ignition 
time 

(Field 
#3)  

Effect 
time 

3 Effect 
Time 

MS - PFT  as an integer 
representatio
n of 1/100 
seconds 

0 - same as 
ignition 
time 

    

(Field 
#4)  

Prefire 
duration 

4 PFT PFT in the format 
0,00 

0.00 - 1.55 = 
1.55 

2.20 = 
2.20 

   

  5 Duration 1 DUR in the format 
0,00 

0.00 - 1.20    If you have a three 
times color 
changing effect = 
duration of effect 1 

  6 Duration 2  in the format 
0,00 

0.00 - 2.10    If you have a three 
times color 
changing effect = 
duration of effect 2 

  7 Duration 3  in the format 
0,00 

0.00 - 1.25    If you have a three 
times color 
changing effect = 
duration of effect 3 

(Field 
#8)  

Step cue 8 S Cue  if two cues 
are to close 
together like 
< 0.30 s we 
have to use 
the step cue 
and step 
delay 

1 - 999      

(Field 
#9)  

Step 
delay 

9 S Delay   as an integer 
representatio
n of 1/100 
seconds  

0.01 - 
99.99 

229.96 = 
22996 

431.46 
= 
43146 

   

(Field 
#10)  

Categor
y 

10 Category  as a string      not really used 

(Field 
#12)  

Effect 
Name 

11 Item TYPE as a string       

  12 Descriptio
n 

EFFECT 
DESC 

as a string  Peony 
color 
changing 

   free text for the 
user 

(Field 
#13)  

Caliber 13 Size CAL as a string 
from VSD 
float 

5 or 125 5 as inch 
or 125 as 
mm 

   free value for the 
user 

  14 Effect 1 CUSTOM8 as a string  Peony 
color 
changing 

   free text for the 
user 

  15 Color 1  as a string  red    free text for the 
user 

  16 Effect 2  as a string  Peony 
color 
changing 

   free text for the 
user 

  17 Color 2  as a string  blue    free text for the 
user 

  18 Effect 3  as a string  Peony    free text for the 

file:///C:/Users/InfinityVisions%20A/Dropbox/INFINITY%20VISIONS%20SOFTWARE/HELP-VSD/HELP%20VSD845/www.infinityvisions.net/Documentation/GalaxisVSDExport.xls
http://www.infinityvisions.net/Documentation/GalaxisVSDExport.xlsx
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color 
changing 

user 

  19 Color 3  as a string  green    free text for the 
user 

  20 Shots  as an integer  16    Shots from a cake 
box  

  21 Pcs QTY as an integer      if you shoot more 
then one 
simultaneously 

(Field 
#22)  

Launch 
Position 

22 Position POS as a string  left; 
center; 
right 

   Firing position 

(Field 
#23)  

Angle 23 Angle ANGLE Angle in degrees, followed by symbol 
font arrow characters dG, dF, and dH, 
e.g., up = 0dG , left = 0dF, right = 0dH 

  with the 
PyrotecComposer.tt
f font you can see 
an arrow in the right 
direction and the 
value in degrees 

  24 Fan Type  as a string      free text for the 
user 

  25 Fan Name  as a string      free text for the 
user 

  26 Tube No.  as a string      free text for the 
user 

  27 Igniter  as a string      free text for the 
user 

(Field 
#28)  

Device 
number 

28 Device ID 
# 

MODULE ID number of 
the receiver, 
receiver 1 to 
999 

1 - 999      

(Field 
#29)  

Output 
number 

29 Output # PIN depends on 
the device 
and extension 
module like 
Matrix 
Module 50 or 
100 Output 

1 - 100 (1 
- 50) 

     

(Field 
#30)  

SC-ID 30 SC-ID AutoCreated unique 
incrementing 
value + 
10000  

10001 -      

  31 DB-ID  unique ID 
number of the 
database 
effect 

      

  32 Rising 
Height 

 as a string      free text for the 
user 

  33 Diameter  as a string      free text for the 
user 

  34 BAM 
Number 

CUSTOM1 as a string      free text for the 
user 

  35 ADR 
Class. 

 as a string      free text for the 
user 

  36 UN 
Number 

CUSTOM2 as a string      free text for the 
user 
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  37 Chipher  as a string      free text for the 
user 

  38 Net weight CUSTOM3 in the format 
0,00 

     free value for the 
user 

  39 Gross 
weight 

CUSTOM4 in the format 
0,00 

     free value for the 
user 

  40 S.D. 
horizontal 

 in the format 
0,00 

     free value for the 
user 

  41 S.D. 
vertical 

 in the format 
0,00 

     free value for the 
user 

(Field 
#42)  

Product 
ID 

42 Item No. REF as a string      free text for the 
user 

  43 Supplier MFG as a string      free text for the 
user 

  44 Producer  as a string      free text for the 
user 

  45 Price PRICE1 in the format 
0,00 

0.00 23.50    free value for the 
user 

  46 Calc. 
Factor 

PRICE2 in the format 
0,00 

0.00 1.40    we calculate Price 
(CP): 1.00 x 1.40 
(Calc. Factor) = SP 

  47 Descriptio
n 

CUSTOM6 as a string      free text for the 
user 

  48 Informatio
n 

CUSTOM7 as a string  nice 
effect 

   free text for the 
user 

  49 Image 
(Path) 

PICTURELIN
K 

as a string      free text for the 
user 

  50 Video 
(Path) 

VIDEOLINK as a string      free text for the 
user 

  51 Indoor  0 or 1      free value for the 
user 

  52 Outdoor  0 or 1      free value for the 
user 

  53 C1  32 bit color 
value of Color 
1 

0 - 
1677721
5 

0 = black 255 = 
red 

65280 
= 
green 

1671193
5 = 
magenta 

 

  54 C2  32 bit color 
value of Color 
2 

0 - 
1677721
5 

1677721
5 = white 

    

  55 C3  32 bit color 
value of Color 
3 

0 - 
1677721
5 

     

  56 Infotext Z1 TYPE max. 16 
characters  of 
ASCII 
Characters 

 gerb step 
run 

   Shows the PFC 
Advanced controller 
during firing 

  57 Infotext Z2 EFFECT 
DESC 

max. 16 
characters  of 
ASCII 
Characters 

 middle of 
stage 

   Shows the PFC 
Advanced controller 
during firing 

  58 Class CUSTOM5 as a string       

  59 Stock 
Place 

MAG as a string       

  60 ShowSim 
Effect ID 

VISUALREF ShowSim 
Effect ID 

      

  61 Part List         

  62 F MACRO empty or F      To separate the 
script; if the 
controller reads a 
"F" -> the controller 
stops and wait till 
anybody press the 
fire button. Is 
sometimes used 
with life music 

  63 Layer  as a string       

  64 Group GROUP as a string      the same name 
belongs to one 
group; just for 
editing 

  65 PAN Angle  same as 
angle 

      

  66 Tilt Angle 
ShowSim 

TILT translated 
values for 
ShowSim 
from Angle 
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  67 Pan Angle 
ShowSim 

PAN translated 
values for 
ShowSim 
from Pan 
Angle 

      

 
 

 

FIREMASTER 
 

Field Firemaster Name VSD Column Comment  

1 Cue Cue  

2 Seq Macro  

3 Rif Group  

4 Start Cue Time Start + Delay = Cue Time, but Delay is not stored seperately 

5 Delay (See Cue Time 
Comment) 

 

6 Address Module / Pin If Unit/Term is provided it is used otherwise Address is split into 
Module/Pin 

7 Unit Module  

8 Term Pin  

9 Group Cghz  

10 Note Effect Description Up to 127 characters 

11 11 - 17 UNUSED   

 
 

EXPLO 
 
 

Field Explo Name VSD Column Comment  

0 Box/Nr MODULE / PIN The module (box) and pin (post) number of the shot. 

1 Explozeit MS The break time of the shot, in the format 00:00.00. (MM:SS.MS) 

2 Abstand Zündzeit NEXT The delay to the next firing row, in the format 00:00.00. (MM:SS.MS) 

3 Effektbezeichnung Effect Desc The effect description. 

4 Stz. PFT The prefire time, in the format 0,0 (comma decimal point). 

5 Efz. DUR The duration of the effect.  Written as whole number of seconds 

6 Efg. TYPE The effect category. 

7 Stop   

8 Stk. QTY Quantity.  total number of devices represented by the firing row. 

9 Beschreibung ANGLE Comment. indicating the angles of the shots, such as ///. 

10 Position  "Position" 

11 Steighöhe  "Rising Height" 

12 Größe CAL "Size" 

13 Etk. CUSTOM8 Label text 

14 Effekttop  "Effect Top" 

15 Gruppe GROUP "Group" 

16 Bereich  "Area" 

17 Winkel TILT Angle. 

18 Pos. POS Launch position. 

19 (no name) REF   
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20 blank  Just to have an trailing TAB on each line 

 
 

PYROLEDA 
 

PyroLEDA Show Director Notes 

“@”   instruction line start character. GEH NOTE will skip 
all other lines 

“cue”   (integer >0) cue id number.  GEH NOTE 
Autoincrements. if cue is zero then we add a row 
with 0 time and this whole line in Event Desc and 
the MACRO is zero 

“time” MS - PFT  (integer >= 0) time in millisecond. 

“trigger”  MODE trigger source can be: MAN, AUTO, SLV 

“group”  CGHZ (integer >= 0 and <= 8) group id. GEH NOTE all 
values 8-16 will be mapped to 8 

“seq” MODULE  (integer > 0) sequencer id. 

“fire” PIN integer > 0 (1-32) to turn on fire line, integer <0 to 
turn it off .  GEH NOTE We can't do negitive pin 
numbers, see [length] 

“fire comment” Event Desc  text string (can be null). 

[“lenght”]  Custom7 optional (can be omitted), integer>0 in 
milliseconds, duration of pulse. Special value 
32768 = infinite (line must be turned off 
explicitly).  GEH NOTE: Stored in Custom7 as "LINE 
ON XX" or "LINE OFF" if pin was negative 

[“voltage”] Custom8  optional (can be omitted), integer>0 in Volt, if 
included, MUST BE Forwarded by the preceding 
length field GEH NOTE stored in Custom8 

 
 

FIRETEK 

 

Field FireTek Name VSD Column Comment  

1 Module Address CONTROL  

2 Slot Address MODULE  

3 Pin Address PIN  

4 IgnitionTime MS-PFT in milliseconds  (Prefire Time, MS - PFT) 
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Scripting  for DMX 

How to program different DMX devices from Show Director / DMX 
Programming for Pyromac 

 
 
Show Director supports DMX devices in two ways.  First by providing a simple way to address a DMX 
controller, channel and value for that channel.  The second is by providing specific devices where multiple 
channels are used.  Below we will provide example of how each can be used. 
Show Director allows for DMX devices to be added to any show script.  Different actions can be specified 
using the existing columns in your script.  One requirement for the DMX devices is that the TYPE column in 
your script must be exactly one of the supported DMX types.  For example, the SimpleDMX type must be 
specified in the TYPE column as "SimpleDMX".  Case and spelling do count.  Other columns will contain 
the additional information based on the DMX command. 

SimpleDMX 

The most basic of the DMX commands is a generic simple command.  This will set  one of the 512 
channels to a specified value.  We allow for CUSTOM1 column to be used to over-ride the PIN column.  
This is so that you can create Effects Manager entries to control the intensity value set to the PIN column.  
If you put a numerical value in CUSTOM1, it will over-ride the value in PIN.  Otherwise, use the PIN 
column. 
 

SD Column Name DMX Note 

TYPE  Must be "SimpleDMX" 

CONTROL Controller One DMX controller universe per serial USB 
connection 

MODULE Channel Values 1 to 512 are allowed 

DUR The duration that this channel will 
have this value before returning to 
zero 

If duration is zero (00:00) then the channel is 
set to value permanently, otherwise max 
duration is 99 seconds 

PIN or CUSTOM1 Value to place on the Channel Values 0 to 255 are allowed. 

 
Here is an example of what a SD script might look like using SimpleDMX commands: 

CU
E 

HH MM SS 
FF 

TYPE CONTRO
L 

MODUL
E 

DUR PIN Event Description 

1 00  00  00  
00 

SimpleDM
X 

C1 12 01:15 255 Turn channel 12 on for 1 
and a half sec 

2 00  00  05  
00 

SimpleDM
X 

C1 7 00:00 127 Set channel 7 to 127 

3 00  00  10  
15 

SimpleDM
X 

C1 7 00:00 0 Set channel 7 to 0 

 
When the DUR column is zero, then the value place on the channel is permanent until changed again by 
another cue.  However, if a duration is provided, then the channel is set to the value in the PIN column for 
the specified time and then the channel is returned to zero.  The limit on duration is 99 seconds. 

Galaxis G-Flame Flame Box 
One of the specifically supported DMX devices is the G-Flame by Galaxis.  Like most flame boxes, the G-
Flame has a safety channel as well as a trigger channel.  In order for the G-Flame to operate, the safety 
channel must first be turned on and later, for safety, must be turned off.  The G-Flame therefore has three 
command: GFlameSafetyOn, GFlameTrigger and GFlameSafetyOff.  These can be called multiple times 
during the show as long as the safety channel is on before any event triggers.  Note that multiple G-Flame 
devices can share a single safety channel.  Here are the SD columns and an example script: 
 

SD Column Name DMX Note 

TYPE  One of the GFlame commands listed below 

CONTROL Controller One DMX controller universe per serial USB 
connection 

MODULE Channel Values 1 to 512 are allowed 



VISUAL SHOW DIRECTOR 8 

61 / 137  

DUR The duration of this flame Must be a value between 00:01 and 25:00 
(maximum duration) 

 
Assuming two G-Flame boxes are configured with safety channel 33 and trigger channel 2 and 17 
respectively: 

CU
E 

HH MM SS 
FF 

TYPE CONTR
OL 

MODUL
E 

DUR Event Description 

1 00  00  00  
00 

GFlameSafetyO
n 

G2 33 00:00 Set channel 33 to GFlame safety 
value 

2 00  00  05  
00 

GFlameTrigger G2 2 00:15 Flame on device 2 for half sec 

3 00  00  05  
00 

GFlameTrigger G2 17 00:15 Also start device 17 for same 

4 00  01  00  
00 

GFlameTrigger G2 2 05:00 Flame on device 2 for 5 sec 

5 00  05  00  
00  

GFlameSafetyOf
f 

G2 33 00:00 Disable both 2 and 17 

 
You should always turn the G-Flame safety on for at least 1 second before any trigger events in order to 
give the flame box time to get activated. 

Le Maitre Salamander Flame Box 
The Salamander Flame Box is a specifically supported DMX device.  Like all flame boxes it has a safety 
channel and a trigger channel.  In order for the flame box to operate, the safety channel must be turned on 
before any trigger commands will activate.  For safety reasons we must also turn the safety channel back 
off at the end of the script.  The safety and triggers may be turned on or off any number of times as long as 
the safety is on before any trigger cues are executed.  The Salamander has three commands for this: 
SalamanderSafetyOn, SalamanderTrigger and SalamanderSafetyOff.  Note that multiple Salamander 
devices may use the same safety channel. 
 

SD Column Name DMX Note 

TYPE  One of the Salamander commands listed below 

CONTROL Controller One DMX controller universe per serial USB 
connection 

MODULE Channel Values 1 to 512 are allowed 

DUR The duration of this flame Must be a value between 00:01 and 25:00 
(maximum duration) 

 
Here is an example SD script using two Salamander flame boxes with separate safety channels.  One has 
the safety channel on 1 and trigger on 2, the other safety is 3 and trigger 4. 
 

CU
E 

HH MM SS 
FF 

TYPE CONTR
OL 

MODUL
E 

DUR Event Description 

1 00  00  00  
00 

SalamanderSafetyOn C1 1 00:00 Set channel 1 to Salamander 
safety value for device 2 

2 00  00  00  
00 

SalamanderSafetyOn C1 3 00:00 Set channel 3 to Salamander 
safety value for device 4 

3 00  00  10  
00 

SalamanderTrigger C1 2 00:15 Flame on device 2 for half sec 

4 00  00  10  
00 

SalamanderTrigger C1 4 00:15 Also start device 4 for same 

5 00  01  00  
00 

SalamanderTrigger C1 2 05:00 Flame on device 2 for 5 sec 

6 00  05  00  
00  

SalamanderSafetyOff C1 1 00:00 Disable channel 1 for 2 

7 00  05  00  
00  

SalamanderSafetyOff C1 3 00:00 Disable channel 3 for 4 

 
You should always allow for 10 seconds after turning the Salamander safety channel on before any trigger 
events. 
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Explo X2 Wave Flame Box 

The Explo X2 Wave flame box is specifically supported by SD.  This DMX device sports a moving flame 
head and is a little more complex the some other flame boxes.  SD takes care of this complexity through 
four commands: X2WaveSafetyOn, X2WaveTrigger, X2WaveSeq and S2WaveSafetyOff.  The X2 Wave 
device has a safety channel for each device and they cannot be shared.  A unique feature of the X2 Wave 
is that you only need to set the first channel of the device.  All other features are an offset from that first 
channel and therefore not required to be specified in the SD script.  There are 6 channels in use, so the 
base addresses for any other device must be 6 greater than the base address of the X2 Wave.  If the base 
channel of a X2 Wave flame box is 6, then the next DMX device on the controller must be set to 12 or 
higher otherwise you will have channel conflicts and errors. 
 

SD Column Name DMX Note 

TYPE  One of the GFlame commands listed below 

CONTROL Controller One DMX controller universe per serial USB 
connection 

MODULE Channel Values 1 to 512 are allowed 

DUR The duration of this flame Must be a value between 00:01 and 02:15 
(maximum duration) 

TILT Angle of the flame head 0 degrees is horizontal right, 90 is up and 180 is 
horizontal left.  Negative values may be used 
between 0 and -180 to represent down (-90 is 
down).   

 
CUSTOM2 Speed of flame head When the flame head changes positions, the 

speed at which if moves may be specified.  0 is 
stationary, 1 (slowest) to 255 (fastest).  Default 
movement is fastest. 

REF Built-in X2 Wave sequences There are 70 built in sequences programmed 
into the X2 Wave.  See the X2 Wave user's 
manual for a full explanation of these 
sequences. 

 
Here is an example SD script using the X2 Wave.  Assume we have two devices set to base channel 10 
and 16 respectively. 
 

CU
E 

HH MM SS FF TYPE CONTR
OL 

MODUL
E 

DUR REF TILT CUSTO
M2 

Event Description 

1 00  00  00  
00 

X2WaveSafety
On 

DD1 10 00:0
0 

   Set safety on for device 10 

2 00  00  00  
00 

X2WaveSafety
On 

DD1 16 00:0
0 

   Set safety on for device 16 

3 00  00  10  
00 

X2WaveTrigger DD1 10 00:1
5 

   Flame on device 10 for half 
sec 

4 00  00  10  
00 

X2WaveTrigger DD1 16 00:1
5 

   Also start device 16 for same 

5 00  01  00  
00 

X2WaveTrigger DD1 10 02:0
0 

   Flame on device 10 for 2 sec 

6 00  01  30  
00 

X2WaveTrigger DD1 10 00:0
0 

 135 255 Flame off, move head to 45 
left 

7 00  01  00  
00 

X2WaveTrigger DD1 10 02:1
5 

 45 127 Flame on med wave to 45 
right 

8 00  01  00  
00 

X2WaveTrigger DD1 10 00:0
0 

 90 255 Flame off move to up 

9 00  01  00  
00 

X2WaveTrigger DD1 10 02:0
0 

   Flame on device 10 for 2 sec 
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10 00  01  00  
00 

X2WaveSeq DD1 10 00:0
0 

51   Seq med wave 45 left to 45 
right 

11 00  01  00  
00 

X2WaveSeq DD1 16 00:0
0 

52   Seq med wave 45 right to 45 
left 

12 00  05  00  
00  

X2WaveSafety
On 

DD1 10 00:0
0 

   Disable device 10 

13 00  05  00  
00  

X2WaveSafety
On 

DD1 16 00:0
0 

   Disable device 16 

 
The build in sequences in the X2 Wave are nice in that cue 10 does the same thing as cues 6,7 and the 
duration of the flame is regulated by the sequence, not by the script writers estimation. 

SafeX Flame Jet Flame Box 
The SafeX Flame Jet flame box is another SD supported DMX device.  Like all flame boxes it has a safety 
channel and a trigger channel.  In order for the flame box to operate, the safety channel must be turned on 
before any trigger commands will activate.  For safety reasons we must also turn the safety channel back 
off at the end of the script.  The safety and triggers may be turned on or off any number of times as long as 
the safety is on before any trigger cues are executed.  The Flame Jet has three commands for this: 
FlameJetSafetyOn, FlameJetTrigger and FlameJetSafetyOff.  Note that multiple Flame Jet devices may 
use the same safety channel. 
 

SD Column Name DMX Note 

TYPE  One of the Flame Jet commands listed below 

CONTROL Controller One DMX controller universe per serial USB 
connection 

MODULE Channel Values 1 to 512 are allowed 

DUR The duration of this flame Must be a value between 00:01 and 10:00 
(maximum duration) 

 
Assuming two Flame Jet boxes are configured with safety channel 33 and trigger channel 2 and 17 
respectively: 
 

CU
E 

HH MM SS 
FF 

TYPE CONTR
OL 

MODUL
E 

DUR Event Description 

1 00  00  00  
00 

FlameJetSafety
On 

G2 33 00:00 Set channel 33 to FlameJet safety 

2 00  00  05  
00 

FlameJetTrigger G2 2 00:15 Flame on device 2 for half sec 

3 00  00  05  
00 

FlameJetTrigger G2 17 00:15 Also start device 17 for same 

4 00  01  00  
00 

FlameJetTrigger G2 2 05:00 Flame on device 2 for 5 sec 

5 00  05  00  
00  

FlameJetSafety
Off 

G2 33 00:00 Disable both 2 and 17 

 
You should always turn the Flame Jet safety on for at least 1 second before any trigger events in order to 
give the flame box time to get activated. 

CRGBLight 
A very common DMX controlled light is one with four channels that does Red, Green and Blue colors.  
Show Director Control has provided a TYPE for this light.  The Control for the light is in the PIN (or 
CUSTOM1) column and is light specific as to how values control the light.  Typically 0 turns the light off and 
255 will use the values of Red, Green and Blue to set color and intensity.  Your lamp may have other 
features that are controlled using the PIN column.  Consult your manual.  To specify a color, you need to 
have the start of the Effect Description have a '#RRGGBB' hexadecimal value.  These values are two hex 
characters each for red, green and blue.  So, for example, #FF0000 would be full red.  #00FF00 would be 
full Blue, etc.  #7F0000 would be half intensity red.  #00FFFF would be bright cyan.  If you provide a 
duration, the light will turn on for than amount of time and then turn itself off. 
 

SD Column Name DMX Note 

TYPE  Must be "CRGBLight" 
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CONTROL Controller One DMX controller universe per serial USB 
connection 

MODULE Channel Values 1 to 512 are allowed.  Each 
CRGBLight uses 4 contiguous channels.  
Next device must be 4 higher than the value 
used here. 

DUR The duration that this channel will 
have this value before returning to 
zero 

If duration is zero (00:00) then the channel is 
set to value permanently, otherwise max 
duration is 99 seconds 

PIN or CUSTOM1 Control value to place on the 
Channel 

Values 0 to 255 are allowed.  Typically 0 is 
off and 255 uses the color and intensity 
provided.  Other values are light specific 
features like blinking and fade. 

Effect Description Color and Intensity of the light Values #000000 to #FFFFFF are allowed 

 
Here is an example of what a SD script might look like using CRGBLight commands: 

CU
E 

HH MM SS 
FF 

TYPE CONTRO
L 

MODUL
E 

DUR PIN Event Description 

1 00  00  00  
00 

CRGBLight C1 1 01:15 255 #FFFFFF bright white for 
1.5 seconds 

2 00  00  05  
00 

CRGBLight C1 1 00:00 255 #FF0000 full red on 

3 00  00  10  
15 

CRGBLight C1 1 00:00 255 #A5184C switch to 
custom color 

4 00  00  12  
15 

CRGBLight C1 1 00:00 0 Turn light off 

 

PanTiltWRGBCYMLight 

Another common DMX controlled light is one with 10 channels that does Pan, Tilt, colors.  Show Director 
Control has provided a TYPE for this light.  In this light, the color is determined by an internal color wheel 
that has 7 colors: White, Red, Green, Blue, Cyan, Yellow and Magenta.  To specify a color, you need to 
have the start of the Effect Description have a '#RRGGBB' hexadecimal value.  These values are two hex 
characters each for red, green and blue.  So, for example, #FF0000 would be full red.  #00FF00 would be 
full Blue, #00FFFF would be bright cyan, etc.  If you provide a duration, the light will turn on for than 
amount of time and then turn itself off.  In addition the light has a swivel head and can be panned or tilted.  
You can pan through 360 degrees and tilt from 0 to 180.  The light can be pan/tilted while the light is off or 
on. 
 

SD Column Name DMX Note 

TYPE  Must be "PanTiltWRGBCYMLight" 

CONTROL Controller One DMX controller universe per serial USB 
connection 

MODULE Channel Values 1 to 512 are allowed.  Each 
PanTiltWRGBCYMLight uses 8 contiguous 
channels.  Next device must be 8 higher 
than the value used here. 

DUR The duration that this channel will 
have this value before returning to 
zero 

If duration is zero (00:00) then the channel is 
set to value permanently, otherwise max 
duration is 99 seconds 

PIN or CUSTOM1 The intensity of the light Values 0 to 255 are allowed.  0 is off through 
255 being full intensity. 

Effect Description Color of the light Values #000000 to #FFFFFF are allowed. 

PAN Pan angle of the light Values 0-360. 

TILT Tilt angle of the light Values 0-180. 

CUSTOM2 Speed of the pan and tilt Values 1-255.  1 is slow, 255 is fast.  Zero or 
blank is fast. 

 
 
Here is an example of what a SD script might look like using PanTiltWRGBCYMLight commands: 
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CU
E 

HH MM SS 
FF 

TYPE CONTRO
L 

MOD DUR PIN PA
N 

TIL
T 

CUSTOM
2 

Event Description 

1 00  00  00  00 PanTiltWRG
BCYMLight 

C1 7 01:15 255    #FFFFFF bright white for 
1.5 seconds 

2 00  00  05  00 PanTiltWRG
BCYMLight 

C1 7 00:00 255 90 45 127 #FF0000 full red on, pan 
90 and tilt up 45, medium 
speed 

3 00  00  10  15 PanTiltWRG
BCYMLight 

C1 7 00:00 255  135 255 #A5184C switch to custom 
color and tilt over to 135, 
fast speed 

3 00  00  12  15 PanTiltWRG
BCYMLight 

C1 7 00:00 0 0 0  Turn light off and return to 
center pan and tilt, fast 
speed 

 
 

DMX programming for Pyromac 
 

Program any DMX device and export to your Pyromac firing system 
 
1) Load Layout "PYROMAC DMX" (See step 1 Addressing Pyromac) 
 
2) We will use columns CUSTOM1 to CUSTOM8. In them you can add the channel values, look at the 
following examples: 
 

 

 
       
To program a DMX device requires the following columns: 
 

Event Description: Device name 

DUR: Duration of the effect.  

MODULE: Channel DMX Device must begin with the number 900.  

PIN or CUSTOM columns  

DMX cues use the PIN column OR the CUSTOM columns.  Usage is determined by: 

• Only CUSTOM columns that are Visible are used.  Hidden columns are ignored so you don't 

generate data you can't see 

• If there are any CUSTOM columns with numerical data (non-alpha) than only the CUSTOM 

columns are used.  PIN is ignored 

• If there are no CUSTOM columns visible or with numerical data, the PIN column is used 

• If CUSTOM columns are used, The CUSTOM column index is added to the MODULE value.  So if 

CUSTOM1 is used, the data is placed on the channel in MODULE.  If CUSTOM2 is used, the channel 

is MODULE + 1.  If CUSTOM3 is used, the channel is MODULE + 2, etc.  There can be up to 8 

channels written per script cue if all eight CUSTOM columns contain valid data. 

• Data in the PIN and CUSTOM columns are range capped to 0-255.  Values below 0 are 0, values 

over 255 are 255 

 

NOTE: If you are getting "Out of range" errors, go to the Cue > Renumber Address dialog and change 

the min and max Module and Pin to reflect the range of values that you may be using.  Just set the Min 

and Max values and then press 'Done', you don't need to renumber the addresses.  This will adjust the 

range checking and stop out-of-range rejections. 
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Scripting Commands and Syntax of Visual Columns 

There are special syntax for each of the following Column fields: 
 

PFT 
 

QTY  
 

PAN & TILT  
 

CAMERA  
 

VISUAL REFERENCE  
 

BEAM  
 

WORLD  
 

OBJECT  
 

VIDEO LINK & PICTURE LINK  
 

PFT 

 
You can select the format of the PFT column.   
 
Click on the Script and press F11, or right click with the mouse over the PFT column header.  
 

1) Select Time formats. 

2) PFT in 1/10 of a Second is written with decimal. Example 8.5=8 and 1/2 second. 

3) PFT in Milliseconds is written from 0000 to 9999 
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QTY 

 

This field contains an integer that can be 0 or not. If 0 is the value no effects will be 

displayed. To shoot the effects 1 must be at least present. 0 will not fire. 

The number of effects shot in the engine is not determined by the QTY value but by the 

number of angles present in the PAN and TILT fields whatever is greater. (for example, if 

three angels 60-90-120 is entered into the TILT Column, three shots will be fired) 3 must be 

entered into QTY solely for inventory purposes. The QTY field should always reflect the total 

number of effects for inventory purposes. 
 

Other fields: PAN & TILT - CAMERA - VISUAL REFERENCE - BEAM - WORLD - OBJECT - 

VIDEO LINK & PICTURE LINK 
 
 

PAN & TILT 

 

This fields contain integer values separated by the - character. Their number determines the 

number of effects to shoot and the angles. 

If PAN angles are not used, the field can be left empty. Only TILT angles will be taken into 

consideration. 
 

PAN is the rotation around Y axis (orientation), and TILT is the rotation around Z axis 

(inclination). 

Normally the X axis is pointing to the right of the audience view and it represents 0 degrees. 

Angles are set counter clockwise 180__|90|__0 
 

The previous versions ANGLE field is not used to fire the effects but only as a reference. It 

admits also symbolic characters like \|/. 
 

Examples: 
 

Example I: 

PAN TILT 

45-90 90 

It specifies 2 effects to be shot; the three effects will have the 
following pair of angles for shooting: 
 
First effect: PAN=45, TILT=90 
Second effect:PAN=90, TILT=90 

 
 

Example II: 

PAN TILT 

0 45-90 

It specifies 2 effects to be shot; the two effects will have the 
following pair of angles for shooting: 
 
First effect:PAN=0, TILT=45 
Second effect:PAN=0, TILT=90 

 
 

Example III: 

PAN TILT 

0-45 0-45-90 

It specifies 3 effects to be shot; the three effects will have the 
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following pair of angles for shooting: 
 
First effect:PAN=0, TILT=0 
Second effect:PAN=45, TILT=45 
Third effect:PAN=45, TILT=90 

 
 

Example IV: 

PAN TILT 

0-45-90 45-60-75 

It specifies 3 effects to be shot; the three effects will have the 
following pair of angles for shooting: 
 
First effect: PAN=0, TILT=45 
Second effect:PAN=45, TILT=60 
Third effect:PAN=90, TILT=75 

 
 

Other fields: QTY - CAMERA - VISUAL REFERENCE - BEAM - WORLD - OBJECT - VIDEO 

LINK & PICTURE LINK 
 

 

CAMERA 

 
 

The camera reference is obtained by pressing the letter “c” in the keyboard while window 

focus is in the Viewer and then pasting it into the Visual Reference field of the Script with the 

mouse right button menu, Paste Selection. 
 

The Camera contains the following string: 

camera(-25.500000*1744.199707*-4560.000000*358.980011*3.060000*0.000000*60*1) 
 

camera(x*y*z*rx*ry*rz*fov*time)     FOV:Field of View ( lens angle) 
 

Where: 
 

 x,y and z are the coordinates of the new positions of the camera. 
 

 rx,ry and rz are the rotation angles of the camera. 
 

 fov is the field of view angle, in this case 60 degrees opening. Human Eye FOV is 120. 
 

 time is the transition time, in milliseconds, for the camera movement. The minimum 

value is 1. 
 

 Cameras can be copied and pasted as regular cues. 
 

 To set a camera transition from one point of View to another, two camera codes are 

necessary. The first code will be the origin point and the second the destination. 
  

 The transition start time is determined in a cue following at least 1 frame of script 

time from where the origin code was pasted. This new line will contain the new destination 

code.The duration of the transition is set in the second (or destination code) at the last digit 

for time. 
 

 The sign # in front of the camera code cancels a camera action, so it is not necessary 

to delete the code, while rehearsing a position. 
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# camera(-25.500000*1744.199707*-

4560.000000*358.980011*3.060000*0.000000*60*1) 

 
 

Other fields: QTY - PAN & TILT - VISUAL REFERENCE - BEAM - WORLD - OBJECT - VIDEO LINK & 

PICTURE LINK 
 
 

VISUAL REFERENCE 

 

The Visual reference code is obtained with the VSD FXGenerator, it contains the name of 

the effect and its variations in color, size and height. It is a necessary field to display the 

effect. 
 

This field has the following syntax: 

shoot(Chrysanthemum*0000FF-FFFFFF-FFFFFF*0*0) 

shoot(effect name *color string *opening radius*height) 
 

Where: 
 

 Effect name is the name of the effect to be shot. 
 

 Color string is the color string for the effects; it must be written with the following 

Hexadecimal color syntax: 

RRGGBB-RRGGBB-RRGGBB 

where R, G or B is any hexadecimal digit from 0 to F corresponding to the decimal value of 

the color. 
 

Example: 

White = FFFFFF, 

Black = 000000, 

Red = FF0000, 

Green= 00FF00 

Blue=0000FF 
 
 

To understand Hex colors Read This 
 

The color string can be modified directly, without the use of the FXGenerator, if a set of 

colors and hexadecimal values are known. 
 

 Opening and height are the alternative opening radius and height for the effects. 

Opening is only relevant for the Shell effect types, not for Ground effects. 
 
 

Other fields: QTY - PAN & TILT - CAMERA - BEAM - WORLD - OBJECT - VIDEO LINK & 

PICTURE LINK 
 
 

BEAM 

Script Commands and Syntax: BEAM 

 

BEAM ( lighting & lasers and image projections) 

 

The beam reference is built inside the VsdPos3D and can be exported (copied to the 

clipboard) from inside the VsdPos3D by right-clicking and selecting Export key-framing string. 

https://en.wikipedia.org/wiki/Web_colors
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The string code has the following syntax: 
 

beam(300*1*Z90*1*0*300*Y0*1*0*300*X0*1*0*300*CFFFF80*1*FFFF80*300*O1*1*1*3

00*D5*1*5*300*L150*1*150*300*B100*1*100*300) 
 

beam(duration*number of repeats*initial z angle*number of 

angles*angle1*time1*...*angleN*timeN*initial y angle*number of 

angles*angle1*time1*...*angleN*timeN*initial x angle*number of 

angles*angle1*time1*...*angleN*timeN*initial color*number of 

colors*color1*time1*...*colorN*timeN*initial start diameter*number of start diameters*start 

diam.1*time1*...*start diam.N*timeN*initial final diameter*number of final diameters*final 

diam.1*time1*...*final diam.N*timeN*initial length*number of 

lengths*length1*time1*...*length N*timeN*initial brightness*number of 

brightnesses*brightness 1*time1*...*brightness N*timeN) 
 

The values of the string are based in the Modifiers values set in the VSDPOS. An initial cue 

can have a complete number of modifiers and a following one can just have one modifier. 
 

Due to the length and complexity of the strings it is better to modify the values in 

the VSDPOS and export the string. 
 

If you want you can also make modifications directly in the string. Here is an example: 
 

beam(300*1*Z90*1*0*300*Y0*1*0*300*X0*1*0*300*CFFFF80*1*FFFF80*300*O1*1*1*3

00*D5*1*5*300*L150*1*150*300*B100*1*100*300) 
 

Beam (duration (300)*repetition count (1)*Z90*1*0*300 stands for: Z initial is 90, there is 1 

change, 0 is the next Z value, 300 is the transition time*and so on for the others... *C is 

color *O is start diameter*D is final diameter*L is length*B is brightness) 

The letter represents the beam property... Z,Y and X are the beam angles... B is the 

brightness, O and, L is length, and... 

After the letter, there is always the initial value so Z90 means that the initial Z value is 90, 

and so on for the other letters 

The number after the * is the number of transitions 

Then, after this number, there are couples of numbers *N*T where N is the new value of the 

beam property and T is the transition time 

for example: CFFFF80*1*FFFF80*300 means that the initial color is FFFF80... then the color 

changes one time, in particular the new color will be FFFF80 in 3 seconds 
 

Lengths of the beam can be adjusted  

L150*1*150*300 means that the initial length is 150, then the length changes one time, in 

particular the new length will be 150 in 3 seconds 
 
 

Other fields: QTY - PAN & TILT - CAMERA - VISUAL REFERENCE - WORLD - OBJECT - 

VIDEO LINK & PICTURE LINK 
 
 
 

WORLD 

 

The position file project  (.pos) can have multiple Sites with different models or pictures. In 

this case the WORLD field must contain the name of the Site to display. It is possible to 

change in a cue from one WORLD or Site to another by changing the Site name in the WORLD 

column. The Script will change to that WORLD when the cue is shot. 
 

When there is only one Site. The Viewer by default will open that site only. No input in the 

WORLD field is necessary. As soon as there is another site in the Position File, input of 
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specific sites is necessary. 
 

Other fields: QTY - PAN & TILT - CAMERA - VISUAL REFERENCE - BEAM - OBJECT - 

VIDEO LINK & PICTURE LINK 
 
 

OBJECT 

 

The Object field is used to control the animation of the objects inside the models or the sites. 

An object with an attached effect can rotate around itself, like a Saxon, or it can move across 

the site, like a boat. 
 

The Object reference is built inside the VsdPos3D and can be exported (copied to the 

clipboard) from inside the VsdPos3D by right-clicking and selecting Export key-framing string. 
 

The syntax is the following: 

 

object(Ellipse_4x_I1*1*1*2000*0*1*0*0*720*0) 

object(name of the object*1*1*time*0*1*0*0*total rotation angle*0) 
 

The string code can be copied and pasted and the Object manually renamed to do the same 

operation for similar objects. 

The Duration time in milliseconds can be adjusted. In this case is 2000 or 2 seconds, but the 

value can be altered to increase or decrease the duration of the movement. 

The Total rotation angle can be increased or decreased or change the direction by inserting a 

negative number. Positive number is clockwise direction, and negative (-720) is counter 

clockwise. 
 

If we change as: 

object(Ellipse_4x_I2*1*1*10000*0*1*0*0*-1440*0) 

In this case the object is a similar one, number I2 ,will rotate during 10 seconds and 4 times 

around itself (4x360=1440). 
 

Other fields: QTY - PAN & TILT - CAMERA - VISUAL REFERENCE - BEAM - WORLD - 

VIDEO LINK & PICTURE LINK 
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VIDEO LINK & PICTURE LINK 

 

PICTURE LINK 

 

This field is used to link pictures to the effects. Normally these are set in the Effects Manger. 

The pictures will be used to render a synchronized to cues slide show with the PRODUCER 

option. 

The pictures are not displayed in the Viewer, only in the final rendered movie. 
 
 

VIDEO LINK 

 

This field is used to link video clips to the effects. Normally these are set in the Effects 

Manager. 

The video clips will be used to render a synchronized to cues slide show with the PRODUCER 

option. 

The video clips are not displayed in the Viewer, only in the final rendered movie. 
 
 

Other fields: QTY - PAN & TILT - CAMERA - VISUAL REFERENCE - BEAM - WORLD - 

OBJECT 
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Cues Menu 

Working with Cues 

 

Show Director offers a wide number of functions, options and choices that work with the 

Script Manager. 
 

From the [CUES] menu the following functions are available: 
 

 Save New Cues 

 Clear New Cues 
 

 Copy Cues 

 Cut Cues 

 Paste Cues 

 Duplicate Cues 

 Insert Cues 

 Insert Effects 

 Create Effects 

 Update Effects 

 Create Macro 
 

 Capture Cues 

 Renumber Cues 

 Renumber Addresses 

 Validate Addresses 

 Reset Addresses 

 Offset Time 

 Refresh Grid 

 Column Fill Down 

 Cues Invert 

 Cues Auto Complete 

 Locate 
 

 Import Cues 

 Export Cues 

 Group Positions 

 Import Beat 

 Fan Tool 

 Export .chr 
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Save / Clear New Cues 

 

While capturing cues in play mode , if you want to keep the cues, you can save them 

instantly before stopping, or clear them if you do not want to keep them. 
 

This command is active only when Play is running. Once you stop playing the cues are 

automatically inserted in the Script. 
 
 

Copy, Cut, Paste and Duplicate  Cues 

 

You can copy or cut any selection on the Script and paste it in any other cue or selection of 

cues with automatic time reset to the inserted cue. 
 

With Visual Show Director you can Copy selections of cues at different times and Paste them 

in different cues or selections of cues at different times. 
 
 

First: make a Selection. 

If you don't know how to select multiple cues, please refer to Selection Strategies 
 
 

To Copy Press Ctrl+C, select command from Menu or click the related Icon in the toolbar 

To Cut Press Ctrl+X, select command from Cues Menu or click the related Icon in the toolbar. Cut will take off the cues from the Script and store them temporarily in the Clipboard 

To Paste Make first a selection of one or Multiple Cues. Press Ctrl+V, select command from Cues Menu or click the related Icon in the toolbar. 

to Duplicate Press Ctrl+D, select command from Cues Menu or click the related Icon in the toolbar. 

When you are duplicating more than one time, a cue that is part of a group of cues with the same time, make sure that after duplicating it, the cursor always moves back to the first cue, which may be a different effect than the one you want to duplicate. To avoid this problem: 

 Use Copy Paste commands, or 

 Create a sort named “Duplicating” with Time as value 1 and Cue as value –2 (descending). The last cue duplicated will go up and be selected, and you will be able to continue with the duplicate operation. 

 
 

You can now also Copy, Cut and Paste text within cells or from other application. 

Highlight the text string and, clicking on it with the right button of the mouse, 

opens the edit Menu. 
 
 

  

file:///C:/Users/InfinityVisions%20A/Dropbox/INFINITY%20VISIONS%20SOFTWARE/HELP-VSD/HELP%20VSD845/selectionStrategies.html
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Insert Cues 

 

This is a powerful Show Director feature that you can use with great flexibility. It is a real 

time saver. 

At the same time it is a calculator of cue intervals, numbers, within time sequences. 

 

 
 
 
How to use Insert Cues 
 

 Go to Cues Menu and select Insert Cues, or just type Ctrl+I 
 

 The Insert/Edit cues window will open. 
You can use this window to Insert any number of cues, with a selected effect, address, position and Interval 
of firing. 
 
Time/Duration 
 

 Set the time in in Frames or Milliseconds. 

 If after Apply you wan to continue insert cues at the last cue entered, select Update. The Script will 
scroll to the last row and you can create a new sequence. 
 
There are 3 methods of operation. 
 

o Compute # of Cues: You can select a Time in and a Timeout for the effect and interval. Show 
Director will calculate the number of cues necessary. 

o Compute Interval: You can select a Time in and a Time-Out and the number of cues. Show Director 
will calculate the interval in-between cues. 

o Compute Duration: You can select a Time in, the number of cues and the interval. Show Director will 
calculate the Time Out. 
 
To any of these methods you can assign: 
 
The selected effect or effects in Effects Manager. Or type a REF and the effect will be automatically 
selected. 
A position. If you want to create a sequence of position incremental (In) or  decremental (Dec) check 
the corresponding box. 
A Quantity.  
A Description for Event DEscription column. 
An  angle Tilt and  Pan 
A Macro Number or Event (Fireone) 
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Caliber Group Hazard number, and an Event Description. 
Correlative or offset addresses, in HEX and DEC ( module and Pin) 
 
 

To select multiple effects in the Effects Manager, press the Shift key for adjacent effects in the list or the 
Ctrl key for non-adjacent and descending effects selected. The multiple effects selected will be inserted 
with the same time, and as many times as the number of cues at the selected intervals. After filling the 

values on the form, you can press the Compute button to see the results, and adjust if necessary any of 
the values. Clicking Apply or OK buttons inserts the cues in the Script window.  
 
 
 
 
How to Insert One Single empty line 
 
Just press the Ins key in your keyboard below the cue time you want to insert. 
 
 

WATCH VIDEO TUTORIAL 

 
 

  

https://youtu.be/7DXnPHMg0GQ
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Insert Effects 

 

(See also Duplicate Cues) 
 

The same functions as Duplicate cues apply for Insert Current effect. 

In the Effect Manager, select a single effect, subsequent effects, or a nonadjacent selection of 

effects (See also Selection Strategies). 

You can also select multiple cues, and insert the effect or effects in each cue of the multiple 

selections. 
 

Select contiguous rows with the Shift key. 

Select alternate roes with the Ctrl key. 
 
 

In the Script Window: 
 

 Select the row(s) at the time(s) where you want to insert the selection, 

 Select contiguous rows with the Shift key. 

 Select alternate roes with the Ctrl key. 
 

 Press Ctrl-E, select command from Cues menu or click in the Icon. 
 

 All the effects selected will be inserted with the same time. 

In the script window you can type a reference number or the first digits of it in the Script 

window Reference field and you will see how it is located in the Effects Manager, and also 

inserted in the Script. 
 

 

 Once you have the desired effect. 

Press Ctrl+E and the effect(s) will be inserted at the selected cue(s). 
 

If you want to work within a specific category of effects, apply a filter to the Effects Manager, 

and the same functions will apply. 
 
 

Create Effects 

 

You can create a new effect entry in the Effects Manager by selecting the effects in the Script 

and selecting Create Effect from the Cues Menu. 

 

A window will pop up with the following message: 
 
 

 
 

New effect lines will be created in the Effects Manager fro all the effects not already present. 
 

It is necessary to have a distinct  reference number for each effect. REF. 
 

file:///C:/Users/InfinityVisions%20A/Dropbox/INFINITY%20VISIONS%20SOFTWARE/HELP-VSD/HELP%20VSD845/selectionStrategies.html
file:///C:/Users/InfinityVisions%20A/Dropbox/INFINITY%20VISIONS%20SOFTWARE/HELP-VSD/HELP%20VSD845/selectionStrategies.html
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This function is particularly useful when you have a Script that was created without and 

Effects Manger, by typing each effect manually. 
 

Update Effects 

 
All or a selection  of Cues Effects data in a script can be updated from  a new the  loaded  Effects Manager. 
If you  have updated your  Effects Manager with new information, you can quickly update your Script by 
REF number  with  the new data.   
Make a  selection of Cues (or no  selection for the full script) and select from the menus Cues->Update 
Effects.  
 

Add Script Effect to Effects Manager 
 
If a Cues REF number is not in the current Effect Manager, it can be automatically added with all the 
provided effect data by selecting the cue and selecting from the menus Cues->Create Effects 

 

Create Macro 

 
The Macro function uses the MACRO column to set the numbers for the different macros. Make the 

MACRO column visible. 
 
For Pyrodigital* download you will need to copy the MACRO column into the CGHZ column or match 

the numbers. Use the Copy Paste Column Tools. 
 
Select a cue with a MACRO value other than zero and select from the menus Cues->Create Macro.  
 
For the current script view, all cues with the matching MACRO value will be tallied and their Cue Time 

will be set to the value of the highest value.   
 
However, all of the PFT values will be set so that the original cue time is kept.   
 
That is to say that a macro with the correct fire times will be created based on PFT and the highest cue 

time.  
 
* Macros in Pyrodigital are limited to a total of 9.9 seconds time.  After that you will need to break them 

down into separate macros. 
 
 

Macro function for PYROMAC 
 
The MACRO function is useful for scheduling different semi-automatic sequences where the first 
shot is manual and continuous sequence of shots. 
 
To add macros: 
 
1) Layout for Pyromac loaded (see Addressing Pyromac - Step 1) 
 
2) Macro column groups the sequences with the same number 
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3) Export show to the firing system (see Addressing Pyromac - Step 4) 
 
4) Remember to click No to export as Manual Macros 
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Capture Cues/Automatic Beat Detection 

 

    
 

To start capturing cues the Capture Cues function must be on. 

You can do that from the Cues Menu, pressing F2 or clicking in the Streetlight Icon. 
 

When the streetlight icon is on “Green” and in the bottom bar it says “Capture On”, 

you are ready to capture Cues. 
 

The CD and WAV file players have been enhanced to allow the "seek to" operation. 

The user may seek both forward and backward in increments of 5 seconds. Also, by selecting 

a row in the event grid and pressing the Play key the music will seek to that time and begin 

playing. This greatly enhances the ability to quickly review firing sequences. 
 

The Clock on the second left box at the bottom of the screen displays a HH: MM: SS: FF clock 

in sync with the Time Code. 
 

> Press Space-bar, or Click Add Cues on the Wave Display button. 

You can also insert selected effects at the same time that you capture cues pressing the 

Button Add Effects. The Effects Manager needs to be open to have this function enabled. 

Each time you press, the New Cues box displays the total of cues entered, and the Last Cue 

pan the time of the last cue. You can see that the Script window displays the new cues with 

the <CAPTURE> sign in the Event Description column. The columns HH: MM: SS: FF display 

the exact time of the cues. 
 

> Stop playing the music. 
 

The Script Window will update and save automatically the cues entered. You can also save 

the cues at any moment during capture by going to the Cue menu and clicking on Save Cues. 

To review the cue markers in the wave Display you need to PressF8 
 

> Rewind, and Play again. Capture must be ON to play the cues. 
 

The Next cue on the time sequence will be highlighted in blue, and as the cues time match 

the Time Code running clock they will highlighted as well. The Blue highlight is programmed 

to be stable at the center of your window. Therefore at the beginning of the script it will scroll 

down to find the center position of the screen, and at the end will move down until the last 

cue is highlighted. 
 

500 cues may be safely captured before being saved. 
 

If you want to enter a modification or adjustment in the time HH: MM: SS: FF, you can do it 

by selecting the cell and typing a new number. Press Tab to go to the next cell. It is also 

possible to increase or decrease the time value by Pressing (Shift +) to increase, or, (-) to 

decrease (no Shift). 
 
 

Music Beat Detection and Cue Insertion 
 

a. Often you need to insert a large set of cues that are on the beat of the music.  Show 
Director now includes Beat Detection for doing this.  With a wave file loaded and the 
Capture mode off (i.e. "Red Light") , click where you want the capture to start and 
Shift+Click where you want the capture to stop.  If you don't set a starting and/or ending 
point it will use the beginning and end of the wave plot.  Select from the menus Cues-
>Import Beat...  This will bring up the Beat Detection dialog: 
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b. Onset Sensitivity is how sensitive the detection is.  If you have more sensitivity you get 
more cues, possible including false beats or back beats.  Less sensitive you might miss a 
few beats ins quiet sections or if the beat gets too complex.  Play with this setting to get the 
level you want. 

c.  
NOTE: Some .wav files, like those converted from .mp3, may not be able to be beat detected due to not 
having the correct PCM internal format.  We will work on this for a future update. 
 
Watch Video Tutorial 

 

Renumber Cues (F3) 

 
 

Selecting Renumber Cues in the Cues menu or pressing F3 will renumber the cues in the 

entire script or filtered script. 
 

Warning: There is no Undo for this function. Use Restore Backups. 
 

Addressing  (F4) 

 

Show Director allows you to address your script with an important degree of automation and 

verification. You won't need to type every single address. 
 

It is possible to address for multiple firing systems. Pyrodigital uses the ADDR column based 

on hexadecimal address from 000 to 7FF.  

Other systems use Module and Pin. Module from 000 to 999 and Pin from 0 to 100. Control 

can be used for systems that use a Controller or a module with also multiple Slats and Pins.  
 

You need to know the Sort, Filter, and Selection strategies, to use the Renumber Address 

function to its full potential. 
 

Normally to address a script you will do it with a Sort by positions, then by caliber, then by 

quantities, then by Tilt (angle), then by time or product type.  

If you want your show to be progressively fired by time and fire your racks in a spatial 

sequence, you will sort by time (this way you add a safety factor, as in the case of having to 

go to the launching site during firing, you know where there are no shells to be fired). If for 

packing reasons you want to load by type of product you will then sort by product. 
 

If you want to keep this Addressing Script separate from the Time Script, you can copy and 

save it with another name with Explore.  
 

To start addressing then, Sort by Position (POS), then by Caliber (CAL), then by Time (HH: 

MM: SS: FF), and then by Type-Effect Description or Reference.  
 

SHOW DIRECTOR can sort and filter by different categories and apply the combinations to a 

Script View. 

http://www.infinityvisions.net/wp-content/uploads/2015/07/VSD830-WHAT-IS-NEW.mp4
file:///C:/Users/InfinityVisions%20A/Dropbox/INFINITY%20VISIONS%20SOFTWARE/HELP-VSD/HELP%20VSD845/scriptsortfile.html
file:///C:/Users/InfinityVisions%20A/Dropbox/INFINITY%20VISIONS%20SOFTWARE/HELP-VSD/HELP%20VSD845/scriptfilterfile.html
file:///C:/Users/InfinityVisions%20A/Dropbox/INFINITY%20VISIONS%20SOFTWARE/HELP-VSD/HELP%20VSD845/selectionstrategies.html
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Once you have your Script sorted, you can either address all of it at once, or do it by blocks 

based on Filters. 
 

For all the Script: 

 Select the cell where you want to start in the ADD or Module and Pin columns. Type 

the initial address, ex 010. or 1 and 1 and press Enter.  

 Go to Cues Menu and select Renumber Address or Press F4. The form Renumber 

Addresses will pop up. 
 

 
 
 
 

 Pin Range on the module for ADDR (in Hex) 

You can set the pin range to fill the modules. If you want to leave some free addresses 

you can type Min 0 and Max D. In this case the moudule wlil be filed until address C. 

Any range between 0 and F is possible. 
 

 Module address range and Pin range in the module( for Decimal:) 

Select the star module number from 1 to 999 maximum. 

Select the Pin range from 1 to 999 , or 1 to 32, or whatever the module can handle. 
 

 Increment CONTROL: 

This feature is used to address different Controllers when a limit of modules set in 

above parameters is exceeded.  

Or to address a module that has multiple Slats and Pins per Slat. It will change the 

Control Module number after 4 Slats and 12 pins per slat have been used. 
 

 Addressing Conditions. Incrementing Decrementing Pin: 

You can address in any order starting a module from F to 0 or from 32 to 1, or from 

100 to 1, etc. 

Reset Address when CONTROL changes will restart the counting from the 

minimum to the maximum. 
 

 Increment modules when a sort condition changes: 

This is one of the most powerful features of this control. You can automatically change 

to a new module when a positions changes or when a caliber or when multiple 

conditions are met. 
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 Autonumber by POS 
 

Tallies up all the POS values and them supplies module and pin addresses by POS.  From the 
existing Renumber dialog (Cues->Renumber Addresses), notice the new checkbox for 
Auto Address by POS only. 

 
 
Select this option, which will disable other Addressing Conditions, and renumber. 
 
 

After you have finish addressing you can see a Module Report. 

In the module report you can see what pins in each module are used or not. 

and a total count of the modules and which modules belong to each Controller. 

You can save a .xls or .txt file of this report. 
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Addressing Pyromac 
 
Pyromac system is included  to export to both Automatic and Macro mode including DMX 
commands. 
 

1) Download the the "PYROMAC Layout" 

a. Click on the script and press F11 

b. Select Script option in the Grids section 

c. Click Load 

d. Select the Layout "PYROMAC" 

e. Click Done 
 

 
 

2) Address the show 
 

a. Press F4 to address 

b. Set the parameters for MOD and PIN as shown 

c. Click on Renumber  
 
 

 
 

3) Press F8 to update the script before exporting 

4) Exports show for Pyromac shooting system 

a. Click on the menu File > Script File > Export... 

b. Assign a name to your script  

c. Selected Type: Pyromac Script File (* .txt) 

d. Click Save 
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e. You will be prompted on which type of show you have:  Pyromusical or Macros. 

 

 

Validate Addresses (F5) 

 

Once the script addressing is done, you can validate your Script checking for repeated 

addresses. 
 

You can do it now within the application before downloading to the Field Controller. 
 

 Go to Cues Menu 

 Select Validate Addresses, or press F5. 

A window for Duplicate Address Error will pop up, indicating any duplicate addresses or none 

(No duplicate addresses). 
 

    
 

If any Address is duplicated , the message indicates the Cue number and the Address 

duplicated, and at the same time highlighted on the script window the row with the 

error. 

Click OK. Go to the address cell, change it, and press Enter. 
 

For SAFETY reasons you must validate the Script. 

Addresses 000 to 00F, sometimes used for comments, are not excluded on the check. 

Show Director does not allow entering any addresses over 7FF. 
 

If you want to keep duplicated addresses: 

 Click Skip button, at the error prompt 
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Reset Addresses (F6) 

 

Reset addresses, changes all the addresses to HEX 000 or DEC Module 0 and Pin 0. 
 

This is useful when importing a script from an old show that has addresses on it and needs to 

be re-addressed. 

Instead of deleting one by one you can do it all at once. 
 
 

Offset Time (F7) 

 

The Offset feature is necessary when the Time code has changed from your original script or 

if you want to move a group of cues in the timeline. 
 
 
 

 
 
 
 
 

Refresh Grid (F8) 

 

Refresh grid command sorts the script by the current options set in the Sort Menu. 

By default the sort is by Time-PFT-Cue. 
 

Refresh also computes and adds new values for the NEXT column, and updates the Price 1-2-

3 sum. 
 

It also updates the markers on the wave display, if any. 
 

Refresh is necessary to refresh the Viewer file, when new cues with effects in the Script or 

Visual files have been updated. 
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Column Fill Down (F9) 

 

If you want to copy, repeat a value to the following cues, you can use the Fill Down 

command. 
 

1. Select the cell you want to fill down. 
 

2. While pressing the Shift key, select the last row of your fill. The selection is 

highlighted. 

Use Ctrl key to make non contiguous selections. (for more information: Grid Selection 

strategies) 
 

3. Press F9, and the cell will be copied to the cells below the selection 
 
 
 

Note: If you skip the point number 2, the cell will be copied until the end of the 

visible part of the script (sorted and filtered, in other words, it will fill until the end 

of the grid). 
 
 

Cues Invert (Ctrl+Shift F9) 

 

If you want to invert the values of a column or a whole set of cues, you can use the INVERT 

CUES command: 
 
 

To Invert only the content of ONE column: 
 

1. Select the first cell you want to invert in the desired column. While pressing the Shift 

key, select the last row in which you want to invert the content. The selection is highlighted. 
 

2. Press CTRL+SHIFT+F9, and the selected columns content, of the selected rows, will be 

inverted 
 
 

To Invert a whole set of rows content (all but the time): 

1. Select the first row you want to invert. While pressing the Shift key, select the last 

row in which you want to invert the content. The selection is highlighted. 

2. Press CTRL+SHIFT+F9, and the all the rows, except Time, are inverted. 
 
 
 

This function really helps in creating fans and reverse sequences. 

See Video Tutorial Here. 
 
 

  

file:///C:/Users/InfinityVisions%20A/Dropbox/INFINITY%20VISIONS%20SOFTWARE/HELP-VSD/HELP%20VSD845/selectionStrategies.html
file:///C:/Users/InfinityVisions%20A/Dropbox/INFINITY%20VISIONS%20SOFTWARE/HELP-VSD/HELP%20VSD845/selectionStrategies.html
https://youtu.be/9Hfo1yQkcSo
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Cues Auto Complete (Ctrl+F9) 

 

This new function auto-completes sequences of positions, angles and any column you want. 

AutoComplete can be used also in the Time columns HH MM SS FF MS and NEXT to create 

time intervals and sequences. 
 

To auto Fill a column 
 

1. Select the first cell you want to use as the base of the sequence. While pressing the 

Shift key, select the last row in which you want to auto Fill. The selection is highlighted and 

the first two cells of the selection are used to create the sequence. 
 

2. Press CTRL+F9, and the selected columns content, of the selected rows, will be filled 

automatically by the auto-complete function 
 
 

The logic of the auto-complete function 
 

This function is based on the user input. It finds the increment gap in your sequence and 

goes to fill the rest 
 

  If you are using it on the TILT field and the first cell is 20 and the second is 30, it will 

create a sequence of angles 20-30-40 and so on until the last row selected. 

  If you are using it on the POS field and the first cell is A01 and the second is B02, it 

will keep addressing with E03, G04 and so on 

  If you type A01 in the first cell and B01 in the second it will create a sequence like 

A01-B01-C01-D01 and so on until the last row selected. 
 

This function is useful to create angles and positions sequences. Note: the sequence is 

calculated on the first two cells of the selection. 
 

 Version 8.3.4. Added Cue Invert to work on the REF column.  This column has been added to Cue 
Invert, but if you do Invert cells in the column be sure to Refresh References to have all the Effect 
data catch up with the associated new cues. Press Enter in each inverted REF to select the effect 
in the Effects Manager and then Ctrl-E to insert the effect. This feature saves time when you wan to 
invert the order of effects in a sequence, such as colors, etc. 

 

See Video Tutorial Here. 
 
 

Locate (F10) 

 

Locate helps you to go to a certain Cue, Time or Address of the Script. When you have to 

make changes in the addresses of the script, you should use this command. You will be able 

to locate the address and change it to a new one 
 

 
 
 
 
 
 

https://youtu.be/9Hfo1yQkcSo
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Import / Export Cues 

 

This is one of the most powerful functions of Show Director. You can use it to create 

macro scripts and design sequences that you can easily add to any new script. 
 

Import and Export cues Show Director feature works together and in conjunction with Script 

Filter Manager option. 
 

A Filter is a part of the Script. 

It could be a large number of cues corresponding to a song, or several cues for a particular 

sequence. 

The filter can be more specific than only cues. 

You can filter by any entry in the Script. If you want to use a song without certain positions, 

calibers or products, you can filter it. 
 

EXPORT FILTERED CUES: 

1. First create a Filter name in the Script Filter Manager. Make the selection of values for 

every column. 

2. Select the Filter in the Drop down menu. The Script will show only the Filtered Cues. 

3. Select Export Cues in the Cues Menu or click in the Icon 

4. Follow directions in the Save Menu. A new Script file will be created for the Filtered 

Cues. 

Once you have exported the cues or you have another script you can use and import in 

different projects. 
 

IMPORT FILTERED CUES: 

1. Select the Cue or Cue Selection where you want your Script (filtered) 

2. Select Import Cues in the Cues Menu or click in the Icon 

3. Choose the File to Import 

4. The imported Script with cues will be inserted in the Cue or in every Cue of your 

selection. 
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Group Positions 

 
Scripted POSITIONS can be added to a common GROUP.  This makes filtering or sorting easier once you 
have many positions in your show. 
 
1) With your show loaded, bring up the Cues > Group Positions dialog 

2) Create a new Group Name or enter an existing Group Name to add additional positions 

3) Multi-select from the list of Positions those POSITIONS you would like added to the Group 

4) Press Apply and all cues with the selected Position will have the GROUP column updated to the 

new Group Name.  You can delete the names from the GROUP column at anytime and rerun this to 

reassign names. 
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Import Beat from Music 

1. Multi-Select using Shift-Click on the Wave Plot will Select multiple cues. 

a. When the Wave Plot is in Capture mode (i.e. "Green Light"), if you click on the wave plot it 
selects the next nearest cue.  Now if you Shift+Click further along the wave plot, it will 
multi-select all the cues between the two clicks 

 

2. Music Beat Detection and Cue Insertion 

a. Often you need to insert a large set of cues that are on the beat of the music.  Show 
Director now includes Beat Detection for doing this.  With a wave file loaded and the 
Capture mode off (i.e. "Red Light") , click where you want the capture to start and 
Shift+Click where you want the capture to stop.  If you don't set a starting and/or ending 
point it will use the beginning and end of the wave plot.  Select from the menus Cues-
>Import Beat...  This will bring up the Beat Detection dialog: 
 

 
 
Onset Sensitivity is how sensitive the detection is.  If you have more sensitivity you get 
more cues, possible including false beats or back beats.  Less sensitive you might miss a 
few beats ins quiet sections or if the beat gets too complex.  Play with this setting to get the 
level you want. 
NOTE: Some .wav files, like those converted from .mp3, may not be able to be beat 
detected due to not having the correct PCM internal format.  We will work on this for a 
future update. 
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Fan Tool 

 

Create PAN & TILT Fans  
This tool lets you create auto fans in Pan and Tilt.  

 

1) Select the cues you want to add fan 

2) Click on the menu Cues or Icon in the Cues Toolbar. 

3) Select the Fan Tool  

4) Sets the values of Start and End 

5) Click Create Fan  
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Export .Chr (Visual Script File) 

 

.chr file is used by the Viewer graphic engine and it is a copy of the script. 

By default it is created and exported every time you refresh the grid by pressing F8. 
 

It is a good strategy to export it manually if you can't see the script changes reflected in the 

visual components. 
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The Script Filter File 

 

Filtering will cause the Script file to show & hide certain data. For example, if the Script 

contains two field controllers FC1 & FC2 the Script can be Filtered for only one of the field 

controllers, in this case FC1. After being filtered, the script will only display cues to be shot by 

FC1 and the newly filtered Script can therefore be quickly available to load into the Controller. 

This way the show can be designed on One single table. 
 

It contains all possible Filter combinations for all columns that you can create. 

This file can be opened in multiple Projects, saving your preferred filters for future use. This 

window or selection panel serves to create the Table files that will be downloaded to the Field 

Controller. You can assign to every filter a Field Controller ID (serial number, labels..) and a 

Firing Table ID. 
 

There is a Function to see the Unfiltered Cue, to avoid miss-download of firing data. 
 

Steps in Creating a Filter 

 
 
 

NAME: In this field you enter the name of the Filter. This will become the name of the Firing 

Table file (.tab), if you assign a value in the FC ID and FT ID columns. The names of the Filter 

will be displayed in the Drop-Down Toolbar 
 

FC ID: (FIELD CONTROLLER IDENTIFICATION). 

In this filed you enter the number of the Field Controller. It can be any number, no letters. 

You can put the Serial Number to identify the FC if you want. In the Download Manager (see 

later: Firing Tables Manager) you can select each FC with the display of the Tables assigned 

to it. 
 

FT ID: (FIRING TABLE IDENTIFICATION). 

In this field you put the number of the Firing table assigned to the Field Controller. The 

values are hexadecimal, as are in the Firing Tables. Therefore, you can enter up to 12 Tables, 

from 0 to B. The program won’t let you enter a value superior to B. 
 

COLUMN FIELDS: 

The Columns in Green or Red are Ranges: 

 FIELD in Green corresponds to IN value. 

 FIELD in Red corresponds to OUT Value. 
 

If values remain at 0, the range is not taken into consideration. 
 

Sorts and Filters Selection: When you select a name in the Drop-Down menu the Script will 

change accordingly to the settings of the Filter.

 
You can select the Sort and Filter directly from the  Script or Effects Sort & Filter 

Managers. Select/highlight the row and press enter will change the view of the Script or 

Effects Manager, and it will be reflected in the drop down boxes where you previously had to 

do the selections. 
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Script filter File Operations 

 

From the File Menu, the following functions are accessible for the Script Filter File 
 

 NEW 

Creates a new file (it prompts for overwriting if the selected file exists) 

 OPEN 

Opens an existing file 

 SAVE AS... 

Saves a copy of the open File. It is useful to frequently save backups of your file. 

 CLOSE 

Closes the opened file 
 
 

Script Filter Manager Auto Create 

 

You can now automatically create a set of Effect Filters based on column data from Effect 

Manager.  Select a column in Effect Manager then in Effect Filter Manager double-click the 

empty Filter Name cell.  You can also Auto Create with two neighboring  

Columns selected for a compound effect. A dialog will ask if you wish to Auto Create the 

filters, select Yes.   
 

A set of Filters will be created based on the column or columns you selected and the column 

data that matches at least one row in your Effect Manager.   
 

Filter Word based. 

You can create a filter based in a single word or description. Name the Filter and Shift Double 

Click in a cell containing the description. A dialog will ask you if you want to add that 

description to the filter selected. Once included in the Filter you can delete the part of the 

Description that you don't need and leave just the word. You can also type the word directly 

in a Filter column. 
 

Partial Match on Filters  

For Script and Effect Sorts, all text fields now will match case-insensitive on a partial sort.  If, 

for example, you have a Sort for Description that is "Yellow" it will find all Descriptions with 

the word "Crackling" or "crackling" or “CRACKLING". 
 

Easy Add to Script- Effect Filter Manager 

When you have a row selected in Script-Effect Filter Manager and you press Shift-Double 

Click in a cell in the Script- Effect Manager, you will be asked if you wish to add that cell data 

to the selected filter. Yes will add the data into the correct cell, No will go into normal Edit for 

the cell.  

For the Columns VISUALREFERENCE, VIDEOLINK and PICTURELINK that have links to the 

Test Viewer, Video Player or Website, to view the linked effects, just double click to view. 

Other Show Director Changes 
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The Script Sort File 

 

This is very important for organizing the firing Table. Normally the Script is chronological, a 

Sort File will help to arrange the Script based on other parameters. For example, The Script 

can be arranged in order of Position, Caliber, Quantity, Tilt, Reference. This allows the Script 

to be sorted such that Addressing of shots can be done automatically!!! 
 

This contains all possible Sort combinations for all columns that you wan to create. This file 

can be opened in multiple Projects, saving once your preferred sorts for future use.  All 

columns of the Script Manager are present in the Script Filter Manager. 
 

You need to give a name to the Sort and then proceed to insert the values of your Sort 

Order. 

Value 1, will be the first column sorted, and so on. Positive values sort Ascending. Negative 

values sort Descending. 

The display order of the columns in the Script Sort Manager, will change accordingly to the 

sort order, to help you visualize the Sort. 
 

 

 
 
 
 

The Sort names will be displayed in the Script View Tool-bar: 
 

 
When you select a name in the Drop-Down menu the Script will change accordingly to the 

settings of the Sort. 
 

Sorts and Filters Selection  

You can select the Sort and Filter directly from the  Script or Effects Sort & Filter Managers. 

Select the row and press enter will change the view of the Script or Effects Manager, and it 

will be reflected in the drop down boxes where you previously had to do the selections. 
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Quick and Additive Sort 
 

1. Quick Sort by using the three new tool-bar buttons, Sort Ascending, Sort Descending and Clear 
Sort.  Select a column that you want to be your primary sort.  Press either the Sort Ascending or 
the Sort Descending button 

 

 
 

2. If you select additional columns and presses either the Sort Ascending or Sort Descending buttons 
it will add additional levels of sorting.  To clear the quick sort, press the Clear Quick Sort button. 

3. Apply multiple Script or Effects Filters 

a. Selecting one or more Script Filters or Effects Filters and Right Clicking will apply all filters 
selected. 
 

Script Sort File Operations 

 

From the File Menu, the following functions are accessible for the Script sort File 

 NEW 

Creates a new file (it prompts for overwriting if the selected file exists) 

 OPEN 

Opens an existing file 

 SAVE AS... 

Saves a copy of the open File. It is useful to frequently save backups of your file. 

 CLOSE 

Closes the opened file 
 

Quick Sort by using the three new Tool bar buttons, Sort Ascending, Sort Descending and Clear Sort.  
Select a column that you want to be your primary sort.  Press either the Sort Ascending or the Sort 
Descending button 

 

 
 
If you select additional columns and presses either the Sort Ascending or Sort Descending buttons it will 
add additional levels of sorting.  To clear the quick sort, press the Clear Quick Sort button. 

 
Apply multiple Script or Effects Filters 
Selecting one or more Script Filters or Effects Filters and Right Clicking will apply all filters selected. 
 
 
 

Script Views 

 

A Script View is a combination of a Sort and a Filter. 
 

You can name the View for quick access with the Drop-Down Menu in the Toolbar. 
 

This is useful to view parts of the Script (Filters) sorted in a particular Order. 
 

You will find many useful applications for this feature. 
 

There is a limit of 32 names for Views in a Project. 
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The Effects Manager 

 

Effect Manager (Effect Filename.efx) is the Show Director products database. 
 

Show Director can open simultaneously only one Effect Manager and one Script at a time. 

You will be able to create as many Effect Manager databases as you want, for different 

products and show types, and bring them up as you need, but only one at a time. 

Each Effect Manager has unlimited Filters available. (See Effect Filter later). You can have a 

complete database that is filtered by any category of the column Fields. 

You can create an Effect Manager File, from scratch, from another Effect Manager File via 

Filtering and Export, or import from a .csv file created with Excel, Access or any 

database/spreadsheet application. 
 

EXCEL 

You will also be able to export a Show Director Effect file (. efx) to a same (.efx) file (see 

Effect Filter later- Export Effects) or a (.csv)(.xls) formats to be opened with your 

spreadsheet application for more complex editing or presentation. 

To see what is the format of a .csv or .xls, Open a new Effects Manager and then save it as 

.csv or .xls.  

Open it in Excel and use the same format of columns.  

Add your data an reopen the file with Show Director 
 

EFFECTS MANAGER FROM A SCRIPT 

It is possible to create an Effects Manager from the products used in a show. 

Open the Script, and Save As .efx. 

An Effects Manager with the single individual effects used will be created. 

Version 8 

The Columns CUSTOM 1-2-3-4-5 Can be renamed with your own names. Right Click in the Header of the 
column and do it the Form to Change name. 

Different names templates can be saved and applied to new projects. 

  

The Effects File 
 

Data Field Formats 
 

* When importing from .xls or .csv the number of characters will be trimmed to match Show 

Director maximums. 
 

The Script window has the following columns and characteristics: 

  

Column Column Name Column Data Type Comment 

1 CAL  Number(3) Integer value for the caliber of 

these effects  

2 TYPE  Text(36) Text description of the kind or 

family of effect being fired 

3 PFT   Number(5) Pre-fire time in milliseconds 

4 Effect Description  Text(128) Description of the effect 
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5 DUR  Number(4) Integer effect duration in frames 

and seconds (100 = 1 sec) 

6 REF  Text(50) Reference number for the effect 

7 MFG  Text(64) Manufacturer of the effect 

8 MAGAZINE  Number(6) Inventory Quantities. 

9 PRICE1  Number(8) Price of this effect 

10 PRICE2  Number(8) Price of this effect 

11 PRICE3  Number(8) Price of this effect 

12 CUSTOM1  Text(128) Open text field for effects data 

13 CUSTOM2  Text(128) Open text field for effects data 

14 CUSTOM3  Text(128) Open text field for effects data 

15 CUSTOM4  Text(128) Open text field for effects data 

16 CUSTOM5  Text(128) Open text field for effects data 

17 VISUALREFERENCE  Text(255) Text field to describe the name of 

the particle effect 

18 BEAM  Text(255) Text field description of lights and 

lasers 

19 PICTURELINK  Text(255) Text link to a web or disk based 

picture 

20 VIDEOLINK  Text(255) Text link to a web or disk based 

video 
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 AUTO-RESTORE (UNDO) 

 New Auto Restore for Scripts and Effects Managers. This new function will keep a back up of your 

most recent Scripts or Effects Managers making a copy of the files every 5 minutes within 1 hour. There 

will be 12 copies that you can restore at any point on time. The feature is only active with a project open. 
The backup files are stored in a folder inside the directory where the project is saved.The function can be 

manually deactivated by changing On to Off in the file sd.ini in 
C:/Users/username/Appdata/Roaming/ShowDirector. You will never loose more than 5 minutes of work. 
 

 
 

Create a New Effects File 

 

 
 

Creates a new Effects Manager File. 
 

The user is prompted for a valid filename and, if the selected filename corresponds to an 

existing file, the software warns the user and prompts for overwrite. 
 

It is safe to press [NO] if the user doesn't want to overwrite the existing file. 
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Create a new Effects Manager File from the Script 

 

With a Script open you can create an Effects Manager file of all the individual effects present 

in the Script.  

Go to Script Save As and choose .efx 

 

Open an existing Effects File 

 

 
 

Opens an existing Effects Manager File. 
 

If the file that is being opened is from a previous version of Show Director, the software will 

warn the user and will prompt for a filename for the imported version. 
 

It auto-updates the file format. 
 
 

Open and Save Effects  Managers in .csv .xls .efx 

  
 

 
The importing of an Effects manager in .csv or .xls format is done from the File Menu / Effect File / Open 
Menu. 

Imports a .csv or .xls file from Excel or any application supporting the file format.  
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The column formats must be the same as in Show Director Effects Manager. The order of the 

column does not matter. 
 

The column names must be the same as in Show Director but not in the same order.  
 

See the format of the Columns in The Effects Manager  
 

 
 
 
 

  

http://www.infinityvisions.net/doc_vsd/theeffectsmanager.html
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Effects Menu 

Working with Effects 

 

Show Director offers a wide number of functions, options and choices that work with the 

Effects Manager. 
 

From the [EFFECTS] menu the following functions are available: 
 
 

 
 
 

 Refresh Grid 

 Duplicate Effects 

 Column Fill Down 

 Locate Effect Ref # 

 Total Effect 

 Total All Effects 

 Update Effect Totals... 

 Import Effects 

 Export Effects 

 Merge Effects 
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Refresh Grid (Shift+F8) 

 

Refresh grid command updates the Effects Manager Grid. 
 

Please refer to the analogue function of the Script Manager for more information. 
 
 

Duplicate Effects 

 

First: make a Selection. 

If you don't know how to select multiple rows, please refer to Selection Strategies 

 
Press Ctrl+A, select command from Effects Menu or click the related Icon in the tool-bar. 
 

You can now also Copy, Cut and Paste text within cells or from other application. 

Highlight the text string and, clicking on it with the right button of the mouse, 

opens the edit Menu. 
 
 

Column Fill Down (Shift+F9) 

 

If you want to copy, repeat a value to following effects, you can use the Fill Down command: 
 

1. Select the cell you want to fill down. 
 

2. While pressing the Shift key, select the last row of your fill. The selection is 

highlighted. 
 

3. Press Shift+F9, and the cell will be copied to the cells below the selection 
 
 

Note: If you skip the point number 2, the cell will be copied until the end of the 

visible part of the effects file (sorted and filtered, in other words, it will fill until the 

end of the grid). 
 
 

Effects Auto Complete (Ctrl+ F10) 

 

This new function auto-completes sequences of positions, angles and any column you want. 

AutoComplete can be used also in the REF column to create a sequence of references. 
 

The logic of the auto-complete function 
 

This function, is based on the user input. It finds the increment gap in your sequence and 

goes to fill the rest 
 

  If you are using it on the REF field and the first cell is 750001 and the second is 

750002, it will keep adding consequential references.  

  If you are using the CAL column and the first cell is 50 the second 75, it will create a 

sequence 50-75-100-125 and so on until last row selected. 
 

TIP: You can first create duplicates of the same effect (Ctrl-A) and then make the 

sequencing. 
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Note: the sequence is calculated on the first two cells of the selection. 
 

To auto Fill a column 
 

1. Select the first cell you want to use as the base of the sequence. While pressing the 

Shift key, select the last row in which you want to auto Fill. The selection is highlighted and 

the first two cells of the selection are used to create the sequence. 
 

2. Press CTRL+F10, and the selected columns content, of the selected rows, will be filled 

automatically by the auto-complete function 
 

Locate Effect Ref# (Shift+F10) 

 

Locate helps you to go to a certain effect based on reference # 
 

 
 
 
 
 

Total Effect (F12) 

 

This is an inventory-tracking feature. 

In order to operate properly you need to assign the Columns MAGAZINE in the Script 

Manager and Effects Manager to display the total quantities on hand or inventory for each 

product. 
 

To know at any given moment of scripting the quantities of a particular product in 

the script : 
 

 Select the product in the Script 
 

 Select the command in the Effects Menu, Press F 12 or click the Icon. 
 
 

If you have used more quantities than available in inventory the display in MAGAZINE /Script 

Manager will show negative numbers. 
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Total All Effects (F12) 

 

This command extends the inventory account to all the products in the Script Manager. 
 

Please refer to Total Effect function for more information. 
 
 

Update Effect Total (Ctrl+F12) 

 

The Effect Manager can be updated by Subtracting all the product from the selected Script, 

which causes a NEW Effect File to be created. 
 

 
 
 

Import / Export Effects 

 

Import and Export effects Show Director feature works together and in conjunction with the 

Effect Filter Manager option. 
 

A Filter is a part of the Effects File. 

It could be a large number of effects corresponding to a macro area such as outdoor or 

indoor, or several effects from a specific manufacturer. 

You can filter by any entry in the Effects File. 
 

EXPORT FILTERED EFFECTS: 

1. First create a Filter name in the Effects Filter Manager. Make the selection of values for 

every column. 

2. Select the Filter in the Drop down menu. The Effects Manager will show only the 

Filtered Effects. 

3. Select Export Effects in the Effects Menu or click in the Icon 

4. Follow direction in the Save Menu. A new Effects file will be created for the filtered 

effects. 

Once you have exported the effects you have another effects file you can use and import in 

different projects. 
 

IMPORT FILTERED EFFECTS: 

1. Select Import Effects in the Effects Menu or click in the Icon 

2. Choose the File to Import 
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Effects Merge 

 

 
 

Merge an existing Effects Manager into the currently loaded one by selecting Effects->Merge Effects. 
 
It will update the Effects Manager with the new information in the merging Effects Manager. 
 
You can select what columns to include or update in the merge. 
References not found in the current Manager will be added. Matching references will be over written, 
however you may choose not to over-write some columns. Only the columns that are selected will be over-
written. 
 
There is also a Merge option that will find effect in your current Effect Manager that are not in the merging 
Effect Manager and remove them.  This feature is so that you can merge into your current manager only 
those columns you have selected and still remove non-overlapping effects. There is also a Merge option 
that will find effect in your current Effect Manager that are not in the merging Effect Manager and remove 
them.  This feature is so that you can merge into your current manager only those columns you have 
selected and still remove non-overlapping effects. 
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The Effects Filter File 

This File contains all possible Filter combinations for all columns that you create. 

This file can be opened in multiple Projects, saving your preferred filters once for future use. 

This window or selection panel creates the new or partial Effect Files to be exported by 

selecting them in the Effect Filter view and Selecting Export. You can assign to every filter a 

new Effect Manager. 
 

 
 
 

NAME: In this field you enter the name of the Filter. The names of the Filter will be displayed 

in the Drop-Down Tool-bar 
 

When you select a name in the Drop-Down menu the Effect Manager will change accordingly 

to the settings of the Filter. 
 
 

COLUMN FIELDS: 

The Columns in Green or Red are Ranges: 

 FIELD in Green corresponds to IN value. 

 FIELD in Red corresponds to OUT Value. 
 

If values remain at 0, the range is not taken into consideration. 
 

Sorts and Filters Selection  

You can select the Sort and Filter directly from the  Script or Effects Sort & Filter Managers. 

Select the row and press enter will change the view of the Script or Effects Manager, and it 

will be reflected in the drop down boxes where you previously had to do the selections. 
 
 

Script Effects Filter from Effects Manager 

 
By selecting a row or rows in the Effects Manager it will filter all the same effects present in the Script.  Do 
this by pressing ENTER on a row or REF cell in the Effects Manager.   
That will apply a filter on that Effects REF in the Script.  The Filter is additive so more or multi-select of 
Effects rows will create more and more filtered Scripts.  
Use the existing Reset Filter to clear this filter. 
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Effect Filter Manager AutoCreate 

 

You can now automatically create a set of Effect Filters based on column data from Effect 

Manager.  Select a column in Effect Manager then in Effect Filter Manager double-click the 

empty FilterName cell.  You can also AutoCreate with two neighboring  

Columns selected for a compound effect. A dialog will ask if you wish to AutoCreate the 

filters, select Yes.   
 

A set of Filters will be created names based on the column or columns you selected and the 

column data that matches at least one row in your Effect Manager.   
 

Filter Word based. 

You can create a filter based in a single word or description. Name the Filter and Shift Double 

Click in a cell containing the description. A dialog will ask you if you want to add that 

description to the filter selected. Once included in the Filter you can delete the part of the 

Description that you don't need and leave just the word. You can also type the word directly 

in a Filter column. 
 

Partial Match on Filters  

For Script and Effect Sorts, all text fields now will match case-insensitive on a partial sort.  If, 

for example, you have a Sort for Description that is "Yellow" it will find all Descriptions with 

the word "Crackling" or "crackling" or “CRACKLING". 
 

Easy Add to Script- Effect Filter Manager 

When you have a row selected in Script-Effect Filter Manager and you press Shift-Double 

Click in a cell in the Script- Effect Manager, you will be asked if you wish to add that cell data 

to the selected filter. Yes will add the data into the correct cell, No will go into normal Edit for 

the cell.  

For the Columns VISUALREFERENCE, VIDEOLINK and PICTURELINK that have links to the 

Test Viewer, Video Player or Website, to view the linked effects, just double click to view. 

Other Show Director Changes 
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Effects Filter File Operations 

 

From the File Menu, the following functions are accessible for the Effects Filter File 
 
 

 NEW 

Creates a new file (it prompts for overwriting if the selected file exists) 

 OPEN 

Opens an existing file 

 SAVE AS... 

Saves a copy of the open File. It is useful to frequently save backups of your file. 

 CLOSE 

Closes the opened file 
 
 

Multiple Filters Selected for Effect Manager. 

 
 
This tool allows you to select multiple EFFECT FILTER MANAGER filters and apply them to our EFFECT 
MANAGER. 
1) Select the filters you want to apply, you can add multiple filters in 2 ways. 
 
a. Continuous selection: Click on the row of the first filter after pressing SHIFT click the last row of the 
filter applied. 

 
  
b. Non-continuous selection: Select the filters you want to apply by holding down the CTRL key 
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2) Apply filters by right clicking on the EFFECT FILTER MANAGER 
Example: 
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The Effects Sort File 

 

This file window contains all possible Sort combinations for all columns that you create. 

This file can be opened in multiple Projects, saving your preferred sorts for future use. 

All columns of the Script Manager are present in the Script Filter Manager. 
 

 
 
 

You need to give a name to the Sort and then proceed to insert the values of your Sort 

Order. 

Value 1, will be the first column sorted, and so on. Positive values are sorting Ascending. 

Negative values are sorting Descending. 

The display order of the columns in the Effect Sort Manager will change accordingly to the 

sort order, to help you visualize the Sort. 
 

The Sort names will be displayed in the Script View tool bar: 
 

Effects Sort File Operations 

 

From the File Menu, the following functions are accessible for the Effects Sort File 
 
 

 NEW 

Creates a new file (it prompts for overwriting if the selected file exists) 

 OPEN 

Opens an existing file 

 SAVE AS... 

Saves a copy of the open File. It is useful to frequently save backups of your file. 

 CLOSE 

Closes the opened file 
 
 

Quick and Additive Sort 
 

1. Quick Sort by using the three new tool-bar buttons, Sort Ascending, Sort Descending and Clear 
Sort.  Select a column that you want to be your primary sort.  Press either the Sort Ascending or 
the Sort Descending button 

 

 
 

2. If you select additional columns and presses either the Sort Ascending or Sort Descending buttons 
it will add additional levels of sorting.  To clear the quick sort, press the Clear Quick Sort button. 

3. Apply multiple Script or Effects Filters 

a. Selecting one or more Script Filters or Effects Filters and Right Clicking will apply all filters 
selected. 
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Effects Views 

 

An Effect View is a combination of a Sort and a Filter. 
 

You can name the View for quick access with the Drop-Down Menu in the Toolbar. 
 

This is useful to view parts of the Script (Filters) sorted in a particular Order. 
 

You will find many useful applications for this feature. 
 

There is a limit of 32 names for Views in a Project. 
 
 

  



VISUAL SHOW DIRECTOR 8 

116 / 137  

Grid Printing and Formatting 

we are going to explore the printing and formatting features of the new Show Director grid. 
 
Please take your time to explore this section because a well organized workspace really can speed up the 
creation process. 
 
 

See also Custom Reports 

 

Direct Print 

 

Show Director prints all grids in WYSIWYG (What you see is what you get) format, as 

displayed on screen. 
 

You can also use LAYOUTS to create a view of the Script to print. 
 

The printout may be different depending on the screen resolution used and type of printer. 
 

You should create Print Templates in different Projects with the particular settings for each 

printout. The settings will be saved in the Project and every time you open the project with 

the Script you want to print, it will appear showing the Columns and in the sort order you 

want them to appear. 
 

In the creation of Print Project template you will use the following functions: 
 

 Column order 

 Hide 

 Sort 

 Font format 

 Background Color 
 

The Print Menu will allow you to adjust, margins, size and orientation of paper. 
 

Each Print menu can be different depending on the type of printer used. 
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Reports 

 

In this menu are the commands to create simple reports from Script File and Effects File. 

Show Director includes a set of predefined reports. Those reports have been enhanced since 

version 5.1. 

 

 

From the [REPORT] menu the following functions are available: 

 Script... 

 Effects... 
 
 
 

Reports: Overview 

 

Show Director creates various simple pre-defined Reports and Summaries. 
 

Reports are Lists of all the data contained in the Script and Effects Manager, with the applied 

Filter, and with predetermined sorts, following the order of the columns from left to right. 

Summaries are tables with computed information about Caliber use, by subtotals or for each 

individual item. In the lower tool bar there is a summary of Cost for each Price category that 

you can update by pressing F8. 
 
 

The Reports and Summaries open in a separate control window that you can leave open to 

check as you script the show, or send it to Windows toolbar. The window has navigational 

controls, page by page, zoom in and zoom out. 
 

You may also save the report in a large variety of file formats, if you want to open it in 

another application like Excel, Word, etc., to edit the format, alter the order of the columns, 

sort it in a different way, apply other calculations or perform an enhanced printing. 
 

If you require a more complete reporting, you can: 
 

- Import the .scx or .efx files (a mdb format) into Microsoft's ACCESS database program. 

- Export the whole Script or Effects Manager as a .csv file, open it with Microsoft’s EXCEL or 

other spreadsheet/database application. 
 

Show Director exports to a variety of formats that can be treated in other third party 

applications. 

 

For Custom Reports with the SD Tools Plugin go here 

WATCH VIDEO CUSTOM REPORTS 
 

 

 

 

file:///C:/Users/InfinityVisions%20A/Dropbox/INFINITY%20VISIONS%20SOFTWARE/HELP-VSD/HELP%20VSD845/reportEffect.html
https://youtu.be/saEDWJ2sPoo
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Reports: Export and send by email 
 

Event or Script Reports and Effects reports can be delivered via email service or exported to a 

variety of file formats for a more sophisticated printing layout. 
 
 

To export a report: 

Click on the export button (envelope icon) in the report window as shown in the next 

illustration 
 

 
 

the following dialog appears with the all the available options. 
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Custom Reports and Views Script and Effects Managers: Overview 

 

We have added the ability to save a named Custom View that includes the Visible Script 

Columns and their order plus whatever filters or sorts you may have in place.   

These Custom Views can be used in any project without having to load the original Script 

Filter or Sort files.   

In addition to loading a Custom View, you have the ability to Print or Save the Script using 

that View.   

Saving uses the Microsoft Excel format (.xls) and only saves the visible columns in order with 

the filter and sort.   

This differs from normal Script Save as Excel which saves ALL columns and data.   

Use this feature to create Custom Reports that can be applied to any Project.   

A few commonly requested Custom Report Views have been included to get you started. 
 
 

 
 

 

 

Users can customize reports for the Effects Manager or Script Manager. Included in version 

8.4  

1) Click on the menu Reports 

2) Click on the Effects... 
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Script or Effect Reports appears with a variety of preset reports and a section where we can 

create customized reports. 

  

Custom reports are created by customizing the columns, filters, and sorts in the Effect 

Manager and then keeping them together. These reports will be available in all projects to 

any Script. 

Customizing the interface is as follows Reports 

a) Default is a list box where you can edit existing reports show or enter the name of one 

to Add. The first report called 'Default' is the order of the columns in your script when loaded. 

Be careful not to overwrite after loading, printed or saved a custom report, use 'Default' to 

return the script back to its initial state.  Do delete a custom report, select it in the list and 

press the DELETE key. 

b) Load: take the report and applies the selected column hide / show, filter and sort the 

current script depending on how the report was customized. 

c) Print: displays the Print Preview. This button is dimmed if your system has no 

configured printer. 

d) Add: add the report to your set of custom reports. If the name already exists, it 

overwrites this set with the new data. 

e) Save: saves the selected report in an Excel spreadsheet. 

 

Reports: Direct Printing 

 

Show Director reports support direct printing. 
 
 

To print a report: 

Click on the Print button (Printer icon) in the report window as shown 
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Script Reports 

 

A set of predefined reports is available in the Script reports function. 

 
 

Show Report: 

This contains Shot, HHMMSSFF, Caliber, quantity, Type, Effect Description, Position, Address, 

Caliber Group Hazard 
 

Event Report: 

This contains Shot, HHMMSSFF, next, Event description, Caliber, Quantity, Position, Angle, 

Custom 1, Custom 2 
 

Loading Report: 

This contains Cue, Position, Address, Caliber, Quantity, Type, Effect Description, Reference, 

Angle 
 

Product Report: 

This contains Reference, Caliber, Type, Effect Description, Magazine, Position, Quantity Total, 

Address 
 

Loading -Screen Sort Report: 

This contains Cue, Position, Address, Caliber, Quantity, Type, Effect Description, Reference, 

Angle 
 

Set the sort order that you want in the Script with Cues Menu/Sort. 

Select Loading-Screen Sort Report in the Reports Menu. 

 

Product Summary: 

his contains Reference, Caliber, Type, Effect Description, Magazine, Custom 1, Totals 
 

Caliber Summary: 

This contains Caliber and Quantities 
 

Show Effects and Costs: 

This contains Reference, Caliber, type, Effect Description, Quantity, Price 1,2 3 with Totals. 
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Effects Reports 

 

A set of predefined reports is available in the Effects reports function. 

Please remember that the reports are sensitive to the filters and sorts applied 

 
 

Effect Report by Caliber : 

This contains Caliber, Type, PFT, Duration, Effect description, Reference, Manufacturer, 

Magazine, Price 1 
 

Effect Report by Ref : 

This contains Reference, Caliber, Type, PFT, Duration, Effect description, Manufacturer, 

Magazine, Price 1 
 

Effect Report by Type : 

This contains Type, Caliber, PFT, Duration, Effect description, Reference, Manufacturer, 

Magazine, Price 1 
 

Effect Report Screen Sort : 

his contains Caliber, Type, PFT, Duration, Effect description, Reference, Manufacturer, 

Magazine, Price 1 
 

Export all Columns:  

This Contains all the Columns of the Effect Manager 
 
 
 
 

  

file:///C:/Users/InfinityVisions%20A/Dropbox/INFINITY%20VISIONS%20SOFTWARE/HELP-VSD/HELP%20VSD845/EffectSortsFile.html
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Racks Load Report 

1. In VSD, Open a project 

2. Open a script.  This turns on the Script Reports 

 

3. Open the Script Reports and press the "Racks" button 

 

 
 

 

4. This takes a copy of the Script you have open and copies it to a new DB with the same name, but 

with the ".rld" extension.  This is the RackLoadout database.  This is now opened up and placed in 

a grid sorted by position and caliber.  Rackable words are applied to each cue to determine if it is a 

rackable cue.  Then if a Rack Info database is open it is applied to the cues.  The match is made 

using several criteria listed in "Rack Loadout: How Cues are matched up to Racks".  If a matching 

rack with empty tubes is found, the rack name is place in the Rack Name column of the cue.  If no 

match can be found for a rackable cue the word "<<NOMATCH>>" is placed in the Rack Name and 

it is highlighted Red.  If a match is found, but all instances of that rack are full, the rack name will be 

set, but no Rack Instance will be set and it is highlighted Yellow.  

 



VISUAL SHOW DIRECTOR 8 

124 / 137  

 

 

 

5. The rackable match words can be edited from the menus using Edit->Edit Rack Match...  

 

 
 

 

6. This brings up the Rack Matching Types dialog 

 

 
 

 

7. Add/Edit/Delete words from these two lists.  The two lists are applied as follows: 
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o Words from the Non-Rackable Types are looked for in the TYPES and Effects Description 

columns of each cue.  If any of these words are found in either of these columns that cue is 

marked as NOT RACKABLE 

o Words from the Rackable Types are then looked for in the TYPES and Effects Description 

columns of each cue.  If any of these words are found that cue is marked as RACKABLE. 

8. This list is saved in the AppData folder in a .ini like file and are reused for each project.  There are 

only one set of rackable type words. 

9. Now it is time to add a rack database to our project.  Do this by using the menu Edit->Edit Rack 

Info DB... 

10. This brings up the Edit Rack Info dialog 

 
 

 

11. At first it will be empty and you will need to enter the information for each of the rack types you 

have.   

o The NAME must be unique and is used to identify each type of rack you have.   

o MFG and REF are open fields.   

o CAL must be a single caliber number, a caliber list or a caliber range.  If this rack can take 

a specific list of calibers, they are listed separated by a '-'.  For example if it can take 

specifically 10, 20 and 30 caliber tubes, we put "10-20-30".  If the rack can take any caliber 

in a range, the start and stop caliber are separated by a '*'. So for a range between 10 and 

30 we put "10*30". 

o ANGLES must be a single angle number, an angle list or an angle range.  If this is a fan or 

angled type rack with a list of specific angles, the angles must be separated by a '-'.  If this 

is a rack in which any angle can be placed within a range the start and stop value are 

separated by a '*'. 

o PICTURE is an open field and should be used to make a small pictogram that represents 

the angles in the rack.   

o TUBES is the number of tubes in each row of the rack.  If the ANGLES specifies a list, the 

TUBES value should match that list.  For example "30-45-90" should have 3 TUBES.  If the 

ANGLES are a single value or a value range, TUBES tells us how many TUBES will be in 

each ROW.   

o ROW is the number of rows of tubes.  TUBES x ROWS = total number of product that can 

be put in this rack. 

o MAGAZINE is the number of rack of this type you have in your inventory.  So a given 

RACK NAME can have MAGAZINE number of instances to be place in positions.  

o MATERIAL,SIZE and WEIGHT are open fields that you can use to store relevant data to 

this rack.  
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o RESERVE column specifies that the type or rack is reserved for only exact name matching 

using the ANGLES column.  See Appendix A on how matching is applied. 

o AVAILABLE column is a YES or NO value stating if this rack type is available for use by 

this show.  The idea here is that you can exclude whole types of inventory for a show 

without having to edit the MAGAZINE value to zero.   

Pressing the DONE button will save your database.  The Open button will let you open another Rack 
inventory database.  In this way you can have several independent databases, but you can only use one at 
a time. 
 

12. Your grid can be printed out (same as any of the grids in VSD) using the menu Print->Print Rack 

Loadout.  

13. Now that you have all of your cues and racked matched up, it is time to Export  this to a Rack 

Loadout Report.  Do this using the menu File->Export Rack Loadout (.xls). 

  

 

 
14. This will generate a .xls file that has been sorted by POS, CAL and RACK NAME and tallies up the 

QTY from each cue of this type.  Note that if you have a rack with multiple instances in MAGAZINE, 

the INST column will have which instance this cue is in 

15. Any given rack instance can only be in one POS so in this example for POS1, this is one cue in 

one tube and that is all that will be put in this rack.   Below is a fuller example for POS2 
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16. White are rackable cues that are in a rack 

17. Gray are non-rackable cues 

18. Yellow are rackable cues for which a matching rack was found, but there were no empty tubes 

available. 

19. Red are rackable cues for which no matching rack could be found 

20. Total Qty is 'how full is this rack'.  We visually indicate how full it is by color from Red (0% full) to 

Green (100% full).  This makes for a quick way to see how optimally the racks have been used. 

Rack Loadout: How Cues are matched up to Racks 
 

After a cue has been determined to be rackable, a series of matching rules are applied to try to place this 
cue into a rack.  As mentioned earlier, for a cue to be rackable it must have a POS value, it must have a 
CAL value and it must have some correct value in either ANGLE or TILT. 
The restrictions for the cue ANGLE or TILT values are as follows: 

1. If ANGLE is non-blank, then it is used.  Otherwise the value in TILT is used. 

2. The value of ANGLE can specify a rack name and that will be the priority when placing this cue.  

However, if all instances of the rack specified are full, then regular rules for rack matching are 

applied 

3. The value of ANGLE (or TILT) can be a single angle such as "90" 

4. The value of ANGLE (or TILT) can be hyphen separated such as "45-90-135" for a fan.  For this 

cue to be placed into a rack, that rack must have a row with at least 45-90-135 angles based on an 

exact match or wildcard usage. 

5. In all cases, the QTY column must accurately reflect how much product (and therefore how many 

tubes) are required.  For example in the above fan, then QTY would be 3. 
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When rack matching starts, we sort the script by POS value.  This groups the cues by the POS they are at.  
We then take each cue at that position and try to find a matching rack.  If a match is found and that rack is 
empty it is assigned to that POS.  A rack can only be in one POS, so if a different POS also needs this type 
of rack, it will require a new instance of this rack.  The Rack Info DB MAGAZINE value tells us how many 
instances of this rack we have to spread around the different positions. 
 

The values of the cue CAL and ANGLE (or TILT) are looked at during this matching process.  We try several 
times to find the best match between the cue and the racks.  For each of the 'best match' comparisons we 
look at every rack in our inventory.  Racks are ignored for several reasons like it has been made 
unavailable, it is RESERVE, it is already in a POS that is not ours or they are already full.  We start with the 
strictest matching criteria and keep loosening the criteria until we have a match or can't find any rack in 
inventory that will do.  If we find at least one rack in inventory that would have worked, but was not 
available to us, we mark that cue with that rack name but leave the Instance blank.  This way you know 
what we felt was the best match so you may add to the Rack Info DB MAGAZINE value.  If we were unable 
to find any racks that match our cue CAL and ANGLE we mark that cue with <<NOMATCH>> rack name. 
 

The order of the match criteria is: 
 

1. The cue's ANGLE column has a RackName in it.  If we have a rack who's name exactly matches 

the name in the ANGLE column we just use it if it is available and not full.  If we can't find the name 

or all instances of that rack are unavailable we continue.  The Rack Info DB has a column called 

RESERVE that if set to YES, reserves this rack type for only exact name matches.  If the 

RESERVE is set to NO, then it will also be used by CAL/ANGLE matching. 

2. We look for an exact match of the CAL and ANGLE values to the rack CAL and ANGLES values.  

So for example of CAL was "30" and ANGLE was "90" we must find a rack that has CAL and 

ANGLES of "30" and "90" respectively.  If the CAL is "20" and the ANGLE is "15-30-45" we must 

have a rack with the CAL of "30" and the exact ANGLES of "15-30-45".  If no exact match is found 

we continue. 

3. We look for a wildcard match of CAL and an exact match of ANGLE.  This would be a rack who's 

CAL value is a list (like "20-40-60") or a range (like "20*60").  If our CAL matches one of the values 

in the list or falls within the specified range we check ANGLE for an exact match. If no match is 

found we continue. 

4. We look for an exact match of CAL and a wildcard match of ANGLE.  This would be a rack who's 

CAL value is exactly a match, but the ANGLE value finds a wild card match.  So for example if the 

with a cue CAL of "20" and an ANGLE of "45" if we find a rack with CAL of "20" and ANGLES of 

"30-45-90" it would match as there is a "45" spot in the row of angles.  We would also match on a 

rack with a CAL of "20" and ANGLES of "10*80" as 45 falls within the range of 10 to 80 degrees. If 

no match is found we continue. 

5. Finally we look for a wildcard match of CAL and a wildcard match of ANGLES.  This is as wide 

open of a match as we can make looking for any possible rack to put this cue into. 

Once a matching rack is found, we check to see if there are enough tubes available in this rack based on 
the cues QTY value.  If there are, we use this rack.  If not, we continue either finding another instance of 
this rack or looking for another rack type that matches. 
Let's take a look at a very simple Script and a limited Rack Info DB and see how matching would work. 
 

Our Rack Info DB: 
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Our Script in the Rack Loadout form: 

 
 

1. This cue is not RACKABLE (based on our Rack Match word lists) so no rack was assigned. 

2. Here the CAL is "20" and the ANGLE is "90" and that is an exact match of the rack named "rack3" 

3. Here we have CAL of both "50" and "20" with a mix of ANGLES of "90" and "60-90-120" (from 
TILT).  The first cue of this set went to "rack6" because of the wildcard for CAL.  Then the next cue 
goes to "rack6" rather than the exact match in "rack3" because we have changed POS and we only 
had one "rack3" (now in POS1).  The next best match that has an instance available is "rack6".  
We also matched a CAL of "20" and ANGLE of 60-90-120 to the wildcard in both CAL and 
ANGLES that "rack6" has. 

4. When we change POS, we have to leave behind any racks assigned there, even if there were 
available spots. 

5. The rack name "rack4" was giving for this cue and that is the rack given (see #7) 

6. These cues are rackable, but due to the "45" angle we can't put them into any rack.  Notice that our 
Rack Info DB doesn't include any racks with an ANGLES of 45 or a list or range including 45. 

7. Here we have tried to assign this cue to "rack4", but we don't have any available instance of 
"rack4" to put into this POS. 

So looking at  our Rack Info DB and the Rack Load script we can see how the rules for matching 
get applied. 
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Configure Menu 

 

In this menu we have the commands to customize and configure the Timecode and the Wave 
Display.  

 
 

From the [CONFIGURE] menu the following functions are available: 
 

 Time Code 

 Audio Editor 

 Wav Display... 
 
 

Configure TimeCode 

 External Pyrodigital modem (Pyrodigital Time Code) 
 

You will select this option if you are using the Pyrodigital modem connected to the com port 

of your computer with an audio input from a tape with music and Time Code, or a wave file 

with music and Time Code playing from your computer. 

You can play from the computer while Show Director is running. You will need to take a feed 

from the computer external audio L&R channels to one speaker and to the PD modem. 
 

A two-channel (stereo) tape with a Soundtrack and Pyrodigital Time Code recorded. 
 

Use this function if you are using a Tape Player, CD Audio with Music in the Left channel and 

Pyrodigital Time Code recorded in the Right Channel. You can play the CD from your 

computer CD ROM player. Connect the external audio stereo feed to the speaker and to the 

Pyrodigital Modem, respectively. To control the CD use the Microsoft CD player controls. 

Those include forward, rewind and a clock that matches the Time Code clock. This is the most 

reliable way to script the show as you have complete guarantee that there are no gaps due to 

the possible interference of other computer internal operations. 
 

Internal CD ROM 
 

If you have a CD player attached to the computer you can play CDs and capture cues directly 

from them. You will save these song scripts with different names. After, when you edit the 

music soundtrack from the same CDs, you will have to cue first the starting cues of each 

song, and with the command Import Cues insert the song files already cued to the starting 

cue of each song. We will demonstrate this later, in the Import Cues menu. 
 

If you have your soundtrack burned into a CD-ROM or just scripting songs to a CD-Audio, you 

can also use the CD to capture cues. If you are preparing a show you can capture cues from 

songs on various CDs, and when your final soundtrack is edited import the scripts at the 

offset times. 
 

IMPORTANT: 

If you are using a CD ROM, with your soundtrack you have to be aware that some CD 
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recording software requires a minimum of 2 seconds pause in the first track. When you play 

the CD you may observe that the music cues are offset by 2 seconds. To correct this you will 

need to offset all your cues in the Script by 2 seconds. 
 

To do so: 

1. Select the first row and while pressing the Shift cue, select the last row.Go to Cues 

menu and select Export Cues. The save Export cues window will appear. Give a name 

to the Exported cues, ex: 'Script2sec'.Go back to the Script and select all the Rows, by 

selecting the first row, pressing Shift and selecting the last row, then press delete.Your 

Script is empty.Go to the Cues menu and select Import Cues. The Import cues window 

will appear.Select Insert Cue at time, and enter the offset, 2 sec= 00:00:02:00Click 

OK. 

2. The new cues will fill the Script with the 2 second offset. 

You will observe that the music cues and Script cues now match while playing back. 
 

If you are firing the show with a CD, with Music in the Left and Pyrodigital time code in 

the right channel, the CD recording software pause does not affect the synchronization, 

as both channels are playing simultaneously. 
 

A Wave file (.wav): 
 

Wave file configuration is automatically selected when you open a Wave File from the 

File Menu. (See Configuring Wave Display) 
 

 SMPTE Time Code 
 

Show Director supports Scripting directly with SMPTE Time Code. SMPTE Time Code is input 

through a new, optional external SMPTE Time Code Reader, in a manner similar to the 

Pyrodigital Time Code Modem. 

This new SMPTE Modem is available from Pyrodigital Consultants or Infinity Visions. 

Show Director and the new SMPTE Modem support 30fps, 29.97fps-Drop Frame, 25fps, and 

24fps. 
 

For more information about the use of SMPTE and the Modem, click here 
 

 
 

 SMPTE Time Code 

Enable Beep during cue capture. 
 

If you want to hear a beep during cues playback you have to enable this function. 

The beep is actually a. wave file, and you can make any beeps, sounds or words like Fire! 

sound at every cue. 

If you want to change beeps go to Windows Settings-Control Panel-Sounds, Select Default 

Sound, Browse to Sound Director Folder, we have provided you with a collection. If you 

want you can create your own with Microsoft Sound Recorder. 
 

If you can not hear any beeps, check that your multimedia controller for sound has the 

.wave listening enabled. 
 

Depending on the Time Code option that you choose, you will have to change the Time 

Code Configuration. The default configuration is Pyrodigital Time Code /SMPTE 30fps, and 

Port1. 
 
The TimeCode dialog has had additional ComPorts added, upping it from 4 to 16 

 

 With Show Director Tools Plug-in it is possible to generate Pyrodigital FSK and 

SMPTE Time Code. 

file:///C:/Users/InfinityVisions%20A/Dropbox/INFINITY%20VISIONS%20SOFTWARE/HELP-VSD/HELP%20VSD845/smpteModem.html
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Pressing the button Generate Time Code file will open the following window: 
 

 
 

Select the Time Code type, number of seconds to generate, a start time and the name and destination 
for the wave file. 
Click Generate and wait until finished. It will take longer for longer durations 
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Configure Wave Display 

 

 
 
 

If you want to change the colors of 

 the Wave Background 

 the Wave foreground 

 the Caliber plot color 

 the Cue plot color 

 the Cursor Color 
 

or you want to display or not cues or caliber, you can open the Wave Configuration Display 

under the Configuration Menu, and make your selection. 
 

Audio Editor 

 
The Audio Editor is the tool to create a a two channel stereo wave 44.100Hz/16bit file with Time Code 
and Music in separate channels. 
With this tool you can also access the Time Code generator. 
 
You can include a lead time of silence in the music channel to allow the time code to run and be 
detected and synced with the Field Controller. 
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Firing Tables Manager 

 

 All the Download operation is conducted with one single Control Panel in the Manager 

Window 

 The Firing Table selection is done with the Script Filter Manager, as explained in the 

Script File Section. 

 If no Filter is used, all cues are taken to make a unique Firing Table for Download. 

  The number of selectable ports is 16. The port with the Field Controller connected, 

will show the mark << 
 

 

 
 
 

If you have used Filters to separate and specify each Firing Table, the Script Filter Manger will 

look like this: 
 

 
 
 

And the Firing Table Manager, like this: 
 

Field Controller: Selects the Field Controller Number. Firing Tables: Selects the number of 

Tables in conjunction with The Field Controller Memory settings. 
 

Serial Port: Chooses the serial port to send the data to the Field Controller. 
 

Status: Shows the status of the Firing Table: Pending, Downloaded or Failed 
 

If you make a change in the Script, make sure to click UPDATE or UPDATE ALL, to 

reflect the changes in the file downloaded to the Field Controller (.tab) 
 

Click DOWNLOAD and follow the messages to download to the Field Controller. 
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OK. Saves the settings and exits the Firing Table Manager. 
 

Build FSK 

 

Pyrodigital table download has a new feature to output the script to a FSK encoded wave file 

to download to the FC3 via Audio Input. 

This function allows sending the wave file to operator in the field and just downloading via 

audio. 
 

PYROINFINITY FIRING MANAGER 

 

This new firing table manager is used to create firing files for Fire Director control software  

and to program Monetti SQ3 sequencers. 

You can download each SQ3 individually. Tables for each module are created automatically by 

Show Director. 

For operation of the Monetti SQ3 refer to its user's guide. 
 
 

http://www.monetti.net/sq3.htm
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Visual Show Director Manual Mode 

 
 

A new Manual Mode has been integrated in the program to allow the choreography of 

manually fired shows with electric panels. 
 

Description of Manual Mode, when manual mode is entered: 

 If the script window is on the screen, the PFT (PreFire Time/Delay) column is locked 

(i.e. edits not allowed) and the time (HMSF) is adjusted by the PFT. The time displayed is the 

Fire Time. The PFT column is locked, so that when manual mode is terminated, time is 

converted back to the original event time (Firing Time + PFT). 
 

 If the script window in not on the screen, when the script is opened the script will be 

converted to the manual mode (i.e., the time will be adjusted to Fire Time). 
 

When manual mode is active, the Manual Pull Down Menu is enabled. This Menu has 

the following functions: 

 

 CountDown Display 

 Configuration 

 Renumber Cues 

 Validate with Tolerance 

 Add PFT 

 Subtract PFT 

 

Configuration... 

This screen contains all the Manual Mode parameters: The current set includes: 
 

 Cue tolerance 

Specifies how near cues can be to each other. The validate function will use this number to 
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compare cue times (if cues are too close together, they are difficult to Fire on a manual 

panel, consolidate or adjust the script as required). 

 Response Time 

Sets the number of tenths of a second at which the "FIRE" wave file is to be played, to 

compensate for the Firing Operator's Delay in physically initiating the Firing button/probe on 

a manual Firing board. 

 Cue Preview Time 

Set the delay that you want the cue to be announced before it turns red in the display. 

 Max Cue Number 

Set the maximum number of cues of your firing panel per rail/slat before it restarts the cue 

count. If you have 25 cues per slat set it to 25. 
 

Countdown Display 

This window has a countdown HMSF/ Next Cue number /and Fire indicator. Everything is in 

big fonts for easy visibility. 
 

 
 

Renumber Cues 

This function allows a quick and semi-automatic addressing of the number of Firing Positions 

per rail/slat on the manual firing system. It is possible to set the number of cues per rail/slat 

and automatically renumber all the script 
 
 

Validate with Tolerance 

This function flags occurrences of inter-cue times that do not meet the specified tolerance. 

The user specifies a tolerance and is able to select all, or selected cues for validation. It 

operates similar to the address validation in that the user is able to ignore/proceed past 

conditions that fail the check. This function insures that user has not specified cues too close 

together for actual operation of the manual firing system. 
 
 

Add / Subtract PFT 

This function gives the option to add or subtract the PFT. 
 
 

USE OF THE WAVE DISPLAY WITH MANUAL MODE 
 

With the new wave display it is possible to combine the Graphic display of the cues on the 

wave graphic with the Manual Countdown Panel. You will need to deselect wave display and 

caliber display in the Configure Wave-Options. 

This way you will have a graphic plot of the cues only. While you play the music you will be 

able to see the cues coming while the cursor advances and looking at the Count Down 

announce the cue number. 
 
 


